Multiviewer User Guide
Models MV82 and MV164

Revision 1.2 s/w ver 2.0

<= A ‘
a 12 ‘ Comingup et Spor

Hogram Preview

b

Enges 4
A

4 / f f A
ENSEMBLE
D E S | &G N S
Purveyors of Fine Video Gear—Loved Ay £n3/neer5 Wor/deoide




Clearly, Ensemble wants to be in the broadcast equipment business. It's so rare anymore to find a company of this
caliber that has not been gobbled up by a large corporation. They are privately held so they don’t have to please the
money people. They really put their efforts into building products and working with customers.

I'm really happy with the Avenue products and Ensemble’s service, and even more important my engineers are happy.
We’ve continued to upgrade the product and add more cards. We will be rebuilding our production control room and

we will use Avenue again.

~ Don McKay, Vice President Engineering, Oregon Public Broadcasting

Who is Ensemble Designs?

By Engineers, For Engineers

In 1989, a former television station engineer who loved
designing and building video equipment, decided to
start a new company. He relished the idea of taking

an existing group of equipment and adding a few
special pieces in order to create an even more elegant
ensemble. So, he designed and built his first product and
the company was born.

Focused On What You Need

As the company has grown, more former TV station
engineers have joined Ensemble Designs and this wealth
of practical experience fuels the company’s innovation.
Everyone at the company is focused on providing the
very equipment you need to complete your ensemble

of video and audio gear. We offer those special pieces
that tie everything together so that when combined, the
whole ensemble is exactly what you need.

Notably Great Service for You

We listen to you - just tell us what you need and we'll

do our best to build it. We are completely focused on
you and the equipment you need. Being privately held
means we don't have to worry about a big board of
directors or anything else that might take attention away
from real business. And, you can be sure that when you
call a real person will answer the phone. We love this
business and we're here to stay.

Bricks and Mortar of Your Facility

The bricks and mortar of a facility include pieces like
up/downconverters, audio embedders, video converters,
routers, protection switches and SPGs for SD, HD and
3Gb/s. That's what we're focused on, that’s all we do

- we make proven and reliable signal processing and
infrastructure gear for broadcasters worldwide, for you.

Avenue frames handle 270 Mb/s,
1.5 Gb/s and 3 Gb/s signals,
audio and MPEG signals. Used
worldwide in broadcast, mobile,
production, and post.

We're focused on
processing gear-
3G/HD/SD/ASI video,
audio and optical modules.

Come on by and visit us.
Drop in for lunch and a tour!

Shipped with care to
television broadcasters
and video facilities all

| over the world.
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Avenue Multiviewers, Models MV82 and MV164

Overview

Monitoring all your sources is elegant and straight-forward with your new Avenue Multiviewer.
Whether you're displaying a simple quad split, or designing an entire control room wall, the Avenue
MV82 and MV164 Multiviewers provide simple intuitive set-up, powerful display options and pristine
image quality. The newest scaling technology and filtering is incorporated in order to deliver stunning
detail. Image quality is uncompromised, regardless of size, configuration or position in the Multiviewer
screen.Video sources are always displayed at full motion frame rate, even with 16 images on

the screen.

Two multiviewer configurations are available, the MV82 and MV164.The MV82 has 8 source inputs
and 2 outputs while the MV164 has 16 source inputs and 4 outputs. Avenue Multiviewers accept all
standard SD, HD and 3 Gb/s video formats. 1080i or 1080p SDI are output at 59.94 or 50 Hz. Outputs
can be genlocked and timed with respect to house reference. Avenue Multiviewers have a fail-safe
bypass.Input 1 and Output 1 are linked together by a fail-safe relay mechanism, so in the event of a
power or system failure, the signal presented to Input 1 is directly connected to Output 1.When you
need to drive an HDMI video monitor, use a BrightEye 81 SDI to HDMI converter at the monitor.

Independent Control and Edit modes give you the precise control needed for your particular job,
whether you're in engineering or operations. Installation and engineering staff use the Edit mode to
configure the Multiviewer hardware, set up alarms and create screen layouts. Segment producers,
master control operators and QC staff can use the Control windows to see various sources and check
signal quality.

Each Multiviewer output is built on a 4x4 or 3x3 grid. With your computer or tablet, click-to-fill each
cell or group of cells to create the desired output architecture. Fast authoring tools with eyedropper
and paste functions make screen configuration very intuitive. Input source is selected from a drop
down menu. Labels, meters, borders alarms, tally, timers, and clocks are fully configurable. Cell styles
and screen configurations can be saved and easily applied as desired. Editing Screen Layouts and Cell
Styles can be done completely off-line and then applied to the output without loss of sync.

Designing screen layouts is quick and easy from your PC, Mac or tablet. Click-to-fill configuration,
snap-to grids and intuitive menus make setup super-simple.Thumbnail proxies of the actual video
inputs contribute to an easy and natural editing experience. An unlimited number of layouts can

be created offline. The layout editing window is so accurate that one can design a layout without
looking at the actual Multiviewer video output. Multiple screen layouts can be created, saved, and
easily recalled, or applied to other Multiviewer outputs. One Multiviewer screen layout might be for a
QC position while others could be created for a control room, remote truck or producer position. New
screen layouts can be designed while the Multiviewer hardware is in use.

The Avenue Multiviewer’s web control panel can be used on a Mac, PC or tablet, which means the
Multiviewer can literally be used from any location.The browser-based control panel provides
intuitive controls for selecting and monitoring particular video and audio sources.

Multiviewer Training Videos

Avenue Multiviewers offer easy set up and amazing picture quality.
Please click on the link below to view a series of detailed training
videos on the Avenue Multiviewers.
http://www.ensembledesigns.com/training/new-multiviewer-magic-20-training-videos

4 Menu-Timing and TSG
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Avenue Multiviewers, Models MV82 and MV164

Frequently Asked Questions

How do | setup the screen?

Avenue Multiviewers are controlled from your PC, Mac or tablet using a web browser interface — no
special software needed. Start by choosing a 4x4 or 3x3 grid, then click-to-fill the cells with your mouse
or finger.The click-to-fill function lets you determine the architecture quickly and easily. Desktop style
paintbrush and eyedropper tools make layout creation super fast. Sources can be selected or changed
with a pulldown menu. Favorite Screen Layouts can be saved for easy recall. Editing Screen Layouts and
Cell Styles can be done completely off-line and then applied to the output without loss of sync.

Can new layouts be created while the Multiviewer is in use?

Yes. An unlimited number of layouts can be created offline while the Multiviewer hardware is in use,
without affecting the output. And all of the layout preview features are still available.

How well do the pictures line up?

Pictures in the Multiviewer output are always lined up precisely and automatically with the
snap-to grid. You choose your grid architecture and we line up the pictures perfectly every time.

Can | copy the setting from one cell to another?

Yes. Configure a cell exactly how you like it and save it as a template. Saved configurations can be
applied to any cell. Cells can be edited individually, adjusting labels, frame choices, audio meters, and
tally.It's super quick and easy.

How does the tally work?

Two levels of tally provide indication of which sources are active on air.Tally can be independently
assigned to different elements in the makeup of the cell: frame color, label text, and label background.
The tally can follow the Avenue router bus or the Avenue layering engine, or it can tie into an external
system with GPIs or automation control.

Can | provide some operator control but restrict editing?

Yes.Independent Edit and Control modes give users the precise controls needed for their particular jobs.

Is there a way to listen to audio from just one source?

Yes. Use the Solo button to select an audio source to listen to, and still look at all of the video sources.

Do the pictures at the top of the display look as good as those at the bottom?

Yes.We're experts at scaling and that means there is amazing detail in every image, no matter how much
or little it’s scaled. Picture quality is maintained at all sizes and positions.There is zero latency between
images at the top of the screen and those at the bottom, even when it's the same source.

What'’s the warranty?

All products have a 5 year warranty. Software upgrades are free for life.

What's the footprint?

The MV82 is a single module while the MV164 takes up two modules slots in the Avenue 3RU frame.
When space is at an absolute premium, use the MV82 module in the Avenue 1RU frame. Alternately,
the 9480 Multiviewer sub module can be added to the Avenue 9430 Router, providing the powerful
combination of Multiviewer and Router.

www.ensembledesigns.com MV82 and MV164 - page 7



Avenue Multiviewers, Models MV82 and MV164

Multiviewer Set Up and Configuration Examples

The following pages show several examples of how the MV82 and MV164 can be configured and used.

lllustration of 4 x 2 Dual Monitor Set Up for Live Production based on 3 x 3 grid
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lllustration of 8 x 2 Quad-Split Dual Monitor Set Up for Source Monitoring based on 4 x 4 grid
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lllustration of 8 x 1 Single Monitor Set Up for Source Monitoring based on 3 x 3 grid
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Avenue Multiviewers, Models MV82 and MV164

lllustration of 8 source Production Monitor with a 4 source Quad-Split Monitor based on
4 x 4 grid along with a 4 source Lobby Monitor based on 3 x 3 grid

Backplane of MV164 using

12 inputs and 3 outputs
Drag MV Units between
g Multiviewer Drag MV Urits ([§El]) between
Screens to allocate MV Unis Srons o alocate Muitviowsr
- resources. Each MV Unit provides 4 .
Multiviewer resources image cele and 2 datacol. Design screen layouts for
Screens . .
T O & Multiviewer outputs
Each MV Unit provides Bl e Soeen Acte using a web browser on
4image cells and i i an iPad or computer
2 data CeIIS H Time: 0 clocks ¢ H Time: 0 clocks ¢

MV 3 [ multiviewer 3 MV 4 [ multiviewer 4

No Sources
Screen Not Active

Layout | c 1 ¢ || Edie)

Standard: 1080p
V Time: 0 lines

H Time: 0 clocks ﬁ
Layouts
New Layout Create
MV Screen 3 Layout @D |x pelete Duplicate || Edit )
MV Screen 4 Layout X Delete Duplicate || Edit )
Program/Preview [y 1] Delete Duplicate || Edit )
Qct X Delete Duplicate || Edit )
Quad Split @B (X Delete Duplicate || Edit

iPad

Evening,
NEWS
12

-
Coming vp next: Sports

{
[ saT1

Multiviewer Monitor 1

Multiviewer Monitor 2

San Francisco

4:28:31

Multiviewer Monitor 3

www.ensembledesigns.com MV82 and MV164 - page 11



Avenue Multiviewers, Models MV82 and MV164

lllustration of 4 x 4 Quad Monitor Set Up for Source Monitoring based on 4 x 4 grid
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Avenue Multiviewers, Models MV82 and MV164

lllustration of 16 x 1 Single Monitor Set Up for Source Monitoring based on 4 x 4 grid
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Avenue Multiviewers, Models MV82 and MV164

Application Example for Multi-Camera Security and Traffic Cam Recording
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High Performance Flexible Multiviewing

The Avenue MV164 is a high performance multiviewer with exceptional image quality. It can take

up to 16 sources and display them on a single display or screen. Avenue multiviewers are available

as stand-alone multiviewers, or as an option to the Avenue 9430 Integrated Routing System. Avenue
multiviewer outputs are HD-SDI 1080i or 1080p. For installations with fewer images to display, choose
the Avenue MV82 that takes up to 8 sources.

Cost Effective Security and Traffic Monitoring

Many facilities are implementing multiple security camera installations that record the output of each
camera for replay in the event of a security breach.This one-recorder-per-camera approach can be very
costly with large installations.

Another application similar in scope is traffic cam recording. It is not uncommon to have hundreds
of traffic cameras located throughout a metropolitan area, and if the output of each is recorded, the
costs become burdensome. Municipalities may want to playback the recordings of several cameras
simultaneously to understand the cause of traffic congestion or the ripple effect of an incident along
a single stretch of roadway. This can become awkward and unwieldy with single camera recording/
playback. Avenue multiviewers offer an elegant and cost effective solution.

Multiple Cameras, Single Record

The Avenue MV164 can have 16 different security cameras or traffic cams displayed at once on a single
output.This allows record/playback of all sixteen cameras at once, resulting in significant cost savings
over single recording of individual cameras.

www.ensembledesigns.com MV82 and MV164 - page 14



Avenue Multiviewers, Models MV82 and MV164

Multiviewer Installation for Sports Themed Establishments
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Sports For The Masses

Restaurants and pubs around the world are starting to specialize in sporting events. Often times, these
establishments have dozens of displays or projectors installed to display various sporting events for
their customers.These installations vary greatly, but most include one very large screen or projector
and several smaller displays.The large display can be switched to different feeds projecting the
sporting event of greatest interest.

These installations can be costly. Dozens of flat screen displays or projectors scattered throughout the
premises represent significant capital investment, and multiple points of failure. The game feeds need
to be switched quickly and easily to show the most pertinent events and can involve complicated
switching for audio and video. A novel and cost effective way to consolidate the displays is with the
Avenue Multiviewer.

High Performance Flexible Multiviewing

The Avenue MV164 is a high performance multiviewer with exceptional image quality. It can take up
to 16 sources and display them on a single display or screen. |t can be purchased as a stand-alone
multiviewer, or as an option to the Avenue Integrated Routing System.The output of the MV164

is HD-SDI 1080i or 1080p. For installations with fewer images to display, choose the Avenue MV82 that
can take up to 8 sources.

Many Games - Single Display

An Avenue MV164 installed in an Avenue Integrated Router allows 16 different feeds to be ingested.
Using very simple set-up controls, the MV164 can be configured with a single large screen in the
center, surrounded by 12 different sporting events.The output of the MV164 can then be sentto a

single projector. One screen now displays 12 different games around a single large featured game of
the moment.

Complete Control from Anywhere

All Avenue Multiviewers include a built-in web server and Ethernet connector. Connecting to a wireless
network within the establishment allows the bartender or host to quickly switch feeds with any web
browser enabled device such as an iPhone or iPad. Additionally, the overall display can be changed
quickly and easily as various games come and go. This flexibility is perfect for the ever-changing sports
interests displayed in sports bars and restaurants.

www.ensembledesigns.com MV82 and MV164 - page 15



Avenue Multiviewers, Models MV82 and MV164

Output Configuration Options and Examples

Avenue Multiviewers offer many layout options and are quick to configure using the click-to-fill setup.
The MV82 has 8 source inputs and 2 outputs, the MV164 has 16 source inputs and 4 outputs.The below
chart shows configuration options for outputs and the number of images per screen.

Images Per
Inputs Outputs Screen
4 Outputs 4-4-4-4
3 Outputs 4-4-8
16 Inputs
2 Outputs 8-8or 12-4
1 Outputs 16
2 Outputs 4-4
8 Inputs
1 Output 8

Output configuration options

The below diagram shows a few of the layout options available with the 3x3 an 4x4 click-to-fill grids.
From your PC, Mac or iPad, select 3x3 or 4x4 grid. With the click-to-fill grids, just about any layout
option you can think of can be achieved.

1/4 9/16 1/16
16| |
116 | I 1/9 4/9
1/4
I I 1/9

Examples of some grid configuration options

www.ensembledesigns.com MV82 and MV164 - page 16



Avenue Multiviewers, Models MV82 and MV164

Getting Started: Initial Setup

Definition of Terms Used in this Manual

Multiviewer Units - - Each Multiviewer Unit is a token for 4 video sources and 2 data cells.
Each Multiviewer Unit is represented by an icon (shown above) and can be allocated to a Multiviewer
Ouput by dragging it to the desired Screen. When you drag an icon to a Screen, you allocate its
resources to that Multiviewer Ouput.

Screen Layout - This is where Screen Layouts are designed and edited for Multiviewer Outputs.
Screen Layout editing can be done off-line, or on-line (live to the output). Multiple Screen Layouts can
be created, saved, and easily recalled, or applied to other MV Outputs.

Grid - Avenue Multiviewers are grid based to ensure excellent picture quality, proper aspect ratio, and
easy Screen Layout designing and editing. Choose from a 4x4 or 3x3 grid.

Cell - Each cell is the area occupied in the screen by a source. Once a grid is selected, click-and-drag
to populate the cells and determine cell sizes. Then click the configure button in the lower right hand
corner of the cell to customize cell features, or apply a custom Cell Style using the eyedropper and
paintbrush tools.

Cell Style Configuration - This is where Cell Styles are designed. Image size, frames, labels, audio
meters, clocks, alarms, and tally set up are all customizable for each cell. Cell Styles can be created,
saved, and easily recalled, or applied to other cells.

Multiviewer Editing — The process of designing and changing Screen Layouts and Cell Styles.

Editing on-line — The process of making edits to a Layout that is currently being routed to a
Multiviewer output. Edits show on the output live as they are being made.

Editing off-line — The process of making edits to a Layout that is NOT currently being routed to a
Multiviewer output. This is a valuable tool for creating and editing multiple Layouts without effecting
an output. .Once Layouts are fully authored they can be applied to Multiviewer outputs without

loss of sync.

Multiviewer Operator Control - In addition to the hard wired Multiviewer monitor outputs,
Multiviewer outputs can be viewed and/or operated through a web based interface. During the
editing process, each Multiviewer output may be defined as read only, or enabled for Control in the
Control Points menu. Multiviewer Outputs with Control enabled allow an operator to select a solo
audio channel, take a source to fullscreen, change from one Layout to another, and clear alarms.

www.ensembledesigns.com MV82 and MV164 - page 17



Avenue Multiviewers, Models MV82 and MV164

Cabling Up

To set up your Multiviewer, install the module in an Avenue frame and connect your sources and
outputs to the associated BNC connectors on the rear of the frame. Each module comes with rear
lexans that slide over the BNC’s on the rear of the Avenue frame. The MV82 rear lexan is shown below.
Detailed illustrations for all of the Multiviewer front and rear lexans are located in this manual on
pages 75-77.

The Avenue Multiviewer is set up and controlled through a web based interface. To establish an
Ethernet connection to the Multiviewer, connect the included 23700040 Interface Adapter Cable to
the 15 pin female D connector on the rear of the frame that’s associated with the Multiviewer module.
Insert an Ethernet cable in the Y end of the adaptor cable and connect directly to a computer or to
your network as desired. When you initially power up the Multiviewer as received from the factory, it
will have the default IP address of 192.168.1.100. If needed, assign the Multiviewer a new IP address
appropriate for your network. Details and drawings for the 23700040 Interface Adapter Cable are
located on pages 69-70 of this manual.

Connect your Sources and Outputs to the Multiviewer Backplane — Connect any combination of
SD, HD and 3G signals to the Multiviewer inputs. Connect the Multiviewer outputs to monitors or other
destinations. Avenue Multiviewers output 1080i or 1080p at 50 or 59.94 Hz.

MV82 Backplane Diagram, 3RU

mva2
Input 1
(fail-safe)

Connect sources to Inputs 1-8.
All standard SD, HD and 3 Gb/s
video formats are accepted.

Output 2 delivers an SDI
signal. Select between

1080i or 1080p in the
Settings>Multiviewer>Screens
menu.

A
Input 1 and Output 1 are

linked together by a fail-safe —
relay mechanism.In the event

of a power or system failure, the
signal presented to Input 1 is
directly connected to Output 1.

Output 1 select between
1080i or 1080p in the
Settings>Multiviewer>Screens
menu.

Connect the included 23700040

B Input 7
Input 8 l
Interface Adapter Cable to
NE’tWO"k/Ser'a' provide an Ethernet connection

for the Multiviewer’s web
@@@ based user interface, software
upgrades and GPI Control via a
3rd party device.
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Settings>Network Menu

« Address - If Needed, Assign a New IP Address to the Multiviewer - When you initially
power up the Multiviewer as received from the factory, it will have the default IP address
of 192.168.1.100. To change it, use a web browser and browse to the default IP address, the
Settings>General window for the Multiviewer will come up. Click on Network and type the
new IP address into the Address window. Click the Done button in the upper left hand corner.
You may need to temporarily change your computer’s IP address in order to initially see the
Multiviewer on your network.

Alternately, use Avenue PC, an Avenue Table Top Control Panel, or an Avenue Touch Screen
front panel. Go to the IP Address menu and assign an IP Address that is appropriate for

your network.

» NTP Server - The factory set default address for the Multiviewer NTP server is pool.ntp.org.
Another sever or IP address appropriate to your installation may be typed into this field.

» Timezone - Select the appropriate timezone for your location from the pulldown menu.

» System Time - This window reports the system time that is coming from the NTP server. Use
this window to check that your Multiviewer is accessing the correct time.

ﬁ Settings

General Network

MAC Address
Network
b0:a7:2a:00:02:b5
Address
Ports
10.123.222.155
Timing & Genlock Subnet Mask
Test Signals 255.255.0.0
- Gateway
Multiviewer
10.123.123.1
. DNS Server
Control Points
10.123.123.1
External Control NTP Server Timezone
pool.ntp.org | (GMT -8:00) Pacific Time (US & Canada * |
System Time

5 Feb 2014, 13:13:59 -0800

Settings>Network Menu as seen on a web browser
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Authorizing a Control Point
Settings>Control Points Menu

Control Points — When you initially power up the Multiviewer as received from the factory, the
Control Points Needed screen comes up. Type in a Control Point Name and click Request.

Navigate to Settings>Control Points. The requested Control Point Name will be in the Pending
Authorization section. Click Authorize, then click the Done button in the upper left hand corner. The
Control Point will show as Enabled in the Control Points menu.

Mys2

Control Point Needed
You need a Control Point to access "MVB2".
Request Control Point

Control Point Needed message on initial power up

MVE2
E Settings > Control Points
General Control Points

Request a control point by browsing to http://10.123.222.156/.
Network Pending Authorization

Name | truck Authorize Delete

Web Panel most recently at 10.123.3.208
Ports 4

Timing & Genlock

Settings>Control Point Menu: New Control Point Pending Authorization

MVB2
E Settings > Control Points

General Control Points

Request a control point by browsing to http://10.123.222.156/.
Network Control Points

[EI Enabled MName  truck Delete
Web Panel most recently at 10.123.3.208

Multiviewer Gontrol
[ Mv1 [ Mv2

Ports

Timing & Genlock

Settings>Control Point Menu: Control Point “truck” enabled
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Enabling Operator Control for Multiviewer Outputs
Settings>Control Points Menu (continued)

Multiviewer Control - In addition to the hard wired Multiviewer monitor outputs, Multiviewer
outputs can be viewed and/or operated through a web based interface. Each Mutltiviewer output
may be defined as read only, or enabled for Control by checking the associated Multiviewer Control
check box. Multiviewer Outputs with Control enabled allow an operator to select a solo audio channel,
take a source to fullscreen, change from one layout to another, and clear alarms. The Control check
boxes enable operator control on an output by output basis. To enable control in Multiviewer Control
windows, check the MV1, MV2, MV3 and MV4 outputs as desired. The Multiviewer Control windows for
disabled outputs (unchecked boxed) will be read only.

Note: The ability for an operator to select a solo audio channel requires Audio Solo to be enabled in
associated layout. This is done during Screen Layout editing.

M1 64
Settings > Control Points

General Control Points

Request a control point by browsing to http://10.123.222.155/.
Network Control Points

g Enabled MName | truck Delete
Web Panel most recently at 10.123.3.208
Ports — Y
Multiviewer Control
M vt ¢ Mvz ¢ Mva ¢ M4
Timing & Genlock
Test Signals
Multiviewer

Control Points

External Control

Settings>Control Points Menu as seen on a web browser
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Setting a Security Password to Limit Access to Editing Privileges

Settings>General>Security Menu

To set an Admin password, check the Admin Password Required box and click the Change Password
button. Once the password requirement is enabled, users will need to enter the password to access
anything but the Multiviewer Control window portion of the user interface.

MV1 64
E Settings > General

General . General

Information
Network
System Name
MY164
Ports
System Information
Timing & Genlock Modos
MVY164 - Multiviewer .
Test Signals
Module Software API WebUI
Multiviewer 1.1.3b96_w5_RIsC 1.1.3b47_j1 1.1.3b43
Serial Number Module Hardware
Control Points JYRR2034 MV164 45009431 AL
External Control Bootloader Kernel
1.0.8-0024 1.0.8-0024
Security
Admin Password
™ Required Change Password
Update
Load Software
| Choose File | no file selected Start Update

Upload an ".esu" software update package to begin the software update
process. The update process may take several minutes. Make sure that
you don't remove power during the update process.

Settings>General window
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Setting the System Frame Rate Family for the Multiviewer
Settings>Test Signals Menu

Use this menu to select the System Frame Rate for the Multiviewer. Choose the Standard and select
test patterns for TSG1 and TSG2.

« Standard - The System Frame Rate for the entire Multiviewer is determined by the Standard
you chose for the Primary Test Signal Generator. For example, if TSG1 is configured for
1080i/59.94, then the Multiviewer will work in any of the 59.94 family standards. All inputs
must be within the frame rate family that is determined by TSG1. Multiviewer outputs
are 1080i or 1080p 50 or 59.95. Whether the outputs are 50 or 59.94 is determined by the
selection here of the Primary Test Signal Generator. 1080p or 1080i may be selected on an
output by output basis in the Settings>Multiviewer>Screens menu.

Select the Standard appropriate for your installation for the Primary Test Signal Generator,
and therefore the System Frame Rate, as follows:.

For 59.94 Hz - select 1080i/59.94, or any of the following from the 59.94 Hz family:
SD525, 720p/59.94, 1080i/59.94, 1080p/59.94

For 50 Hz - select 1080i/50, or any of the following from the 50 Hz family:
SD625, 720p/50, 1080i/50, 1080p/50

MV164
ﬁ Settings > Test Signals
General Test Signals
720p/50 rator
Network 720p/59.94
720p/60 Pattern Switch Mark
1080i/50
| SWPTE Bars :] o Enabled
PO”S 1080i/60
1080p/25
1080p/23.98
Timing & Genlock 1080p/24
1080p/50 ¥
1080p/59.94 &/ ' IIB lincs)
Test Signals 1080p/60
1080sF/25
1080sF/23.98 y
Multiviewer 1080sF/24 0= IIE{ clocks
525i/59.94 .
625i/50
Control Points Reference Level

| -20dBFS |

External Control

Settings>Test Signals Menu as seen on a web browser
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Settings>Test Signals Menu (continued)

» Pattern — Under Primary Test Signal Generator Pattern, select a test pattern for TSG1. Under
Secondary Test Signal Generator Pattern, select a test pattern for TSG2. Factory preset for TSG1
Pattern is SMPTE Color Bars. Factory preset for TSG2 Pattern is Black.

Select from Black, SMPTE Bars, Flat Field 20, Flat Field 80, 20_80 Window, 10 Step, Digital Blanking
« Timing - Under Primary Test Signal Generator Timing, adjust the vertical and horizontal timing of

the primary test signal with respect to the reference. Under Secondary Test Signal Generator Timing,
adjust the vertical and horizontal timing of the secondary test signal with respect to the reference.

ﬁ Settings

General Test Signals
Primary Signal Generator

Network
Standard Pattarn Switch Mark
Black
(‘10s0y/59.94 ‘) o Enabled
Ports Flat Field 20
Timing Flat Field 80
1 20_80 Window
Timing & Genlock extical | 105tep
faul ) Digital Blanking
. Default —k.}—-
Test Signals

Horizontal
Multiviewer Default 0 IIE{ clocks

Audio Embedding
Control Points Reference Level

| -20dBFS ™
External Control -

Group 1

# Enabled  Ch1 | LOKHz #| Ch2| 1L.OKHz #| Ch3| l.OKHz % | Ch4 | lL.OKHz = |

Group 2

™ Enabled ChS5| LOKHz | Ch6| 1L.OKHz #+| Ch7| 1.0KHz #+| ChB| 1.0OKHz % |

Group 3

#Enabled Ch9 | LOKHz # | Ch10 | L.OKHz #|Ch11 [ LOKHz #|Ch12 | LOKHz *|

Group 4

¥ Enabled Ch 13| L.OKHz :| Ch14 [ LOKHz :|Ch15( L.OKHz :|Ch16 | 1.OKHz : |

Slate Slate Text Cyclops

|| Enabled | Cylops Aud F % |

Secondary Signal Generator

Standard Pattern Switch Mark
| 1080i/59.94 : | [ Black s # Enabled
Timing

Vertical

Default 187 IIE{ lines

Settings>Test Signals Menu: Test Pattern choices detail
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Assigning Sources to Outputs: Allocating MV Units

Settings>Multiviewer MV Units Menu

Use this menu to allocate resources to the Multiviewer outputs, to choose the output format for each
output, and to adjust output timing.

MV Units — Each Multiviewer Unit is a token for 4 video sources and 2 data cells. Each
Multiviewer Unit is represented by an icon and can be allocated to a Multiviewer Ouput by
dragging it to the desired Screen. When you drag an icon to a Screen, you allocate its resources
to that Multiviewer Ouput. The MV82 Multiviewer has 2 MV Units available to allocate up to

8 video sources. The MV164 Multiviewer has 4 MV Units available to allocate up to 16 video
sources. In addition to 4 video sources, each MV Unit provides up to 2 data sources from
internally generated clocks. Internally generated test signals are seen as video sources.

After allocating resources, to design and edit Screen Layouts and Cell Configurations, use the
Layout section just below the Screens section. See the Layout portion of this manual for details.

To go to the Multiviewer Control window, click the Done button in the upper left hand corner
of the screen.

The following pages show several examples for MV Unit allocation.

Multiviewer Drag MV Units ( [l ) between
MV Units Screens to allocate Multiviewer
resources. Each MV Unit provides 4
image cells and 2 data cells.
Screens
- MV 1 MV 2
8 Sources / No Sources

Screen Active Screen Not Active

Layout | MV Scr | Edit )y Layout | MV Screen 2 Edit

andard: 1080p
ime: 0 lines
H\ me: 0 clocks

Standard: 1080p
V Time: 0 lines

ﬁ H Time: 0 clocks ﬁ'

Layouts

MNew Layout Create

MV Screen 1 Layout

aD

Delete Duplicate Edit ¥

MV Units are allocated by dragging them to Multiviewer Output Screens. In the above illustration there are 2 MV
Units allocated to the MV'1 Output, making 8 sources available as indicted in bold in the MV1 Screen. To reallocate
sources, drag the MV Unit(s) to the desired MV Output. For example, to reallocate the 8x1 shown above to a 4x2

(4 sources each on the 2 Outputs), drag 1 MV Unit over to the MV2 output, as suggested in the illustration. MV Units
may also be stowed in the MV Units dock at the top left.
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MvB2
Settings > Multiviewer

General

Network

Ports
Timing & Genlock

Test Signals

Multiviewer

Control Points

External Control

Multivi r Drag MV Units (SRl ) between

MV Units Screens to allocate Multiviewer
resources. Each MV Unit provides 4
image cells and 2 data cells.

Screens

I =

‘urces 4 Sources
*n Active Screen Active

MV Screen 1 4 || Edit ) Layout | MV Screen 2 ¢ || Edit )
1080p Standard: 1080p
nes V Time: 0 lines
cks ﬁ H Time: 0 clocks ﬁ
Layouts
New Layout Create
MV Screen 1 Layout m ¥ Delete Duplicate || Edit )
MV Screen 2 Layout OB | % pelete Duplicate || Edit )

MV82 8x2 example: 2 MV Units allocated, 1 to each MV Output (8 inputs to 2 outputs)
For this configuration, drag 1 MV Unit to each screen to have 4 sources available on one monitor, and 4
sources available on another monitor. Note each MV Screen indicates 4 Sources in bold.

MVB2
m Settings > Multiviewer
General Multiviewer Drag MV Units ( (Sl between
MV Units Screens to allocate Multiviewer
Network resources. Each MV Unit provides 4
image cells and 2 data cells.
Screens
Ports
- MV 1 MV 2
Timing & Genlock 8 Sources No Sources
- Screen Active Screen Not Active
Test Signals Layout | MV Screen 1+ | | Edit ) Layout | MV Screen 2 Edit )
Standard: 1080p Standard: 1080p
Multiviewer V Time: 0 lines V Tirme: 0 lines
H Time: 0 clocks ﬁ H Time: 0 clocks #
Control Points  Layouts
New Layout Create
External Control
MV Screen 1 Layout T |x pelete Duplicate | Edit
MV Screen 2 Layout ¥ Delete Duplicate | Edit

MV82 8x1 example: 2 MV Units allocated to MV1 Output (8 inputs to 1 outputs)
For this configuration, drag both MV Units to 1 screen to have 8 sources available on one monitor.
Note the MV'1 Screen indicates 8 Sources in bold.

www.ensembledesigns.com
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Save Change Settings
General Multl.\ﬂewer Drag MV Units ([l ) between
MV Units Screens to allocate Multiviewer
Network resources. Each MV Unit provides 4
image cells and 2 data cells.
Screens
Ports
' MV 1 | Multiviewer 1 - MV 2 | Multiviewer 2
Timing & Genlock 4 Sources
Screen Active
Test Signals + || Edit ) Layout [ MV Screen 2 2 || Edit )
Standard: 1080i/59.94
Multiviewer V Time: 0 lines
ﬁ H Time: 0 clocks ﬁ
ContrOI POintS - MV 3 | Multiviewer 3 - MV 4 | Multiviewer 4
4 Sources 4 Sources
Sois Lo Screen Active Screen Active
Layout | MV Screen 3+ || Edit ) Layout | MV Screen 4 # || Edit )
Standard: 1080i/59.94 Standard: 1080i/59.94
V Time: 0 lines V Time: 0 lines
H Time: 0 clocks ﬁ H Time: 0 clocks ﬁ

MV164 16x4 example: 4 MV Units allocated, 1 to each MV Output (16 inputs to 4 outputs, or 4 Quad Split outputs)
For this configuration, drag 1 MV Units to each screen to have 4 sources available on each of 4 different monitors.

Note each MV Screen indicates 4 Sources in bold.

Save Change Settings
General Multiviewer .
Drag MV Units (S8l ) between
MV Units Screens to allocate Multiviewer
Network resources. Each MV Unit provides 4
image cells and 2 data cells.
Screens
Ports
- MV 1 | Multiviewer 1 - MV 2 | Multiviewer 2
Timing & Genlock 4 Sources 4 Sources
Screen Active Screen Active
Test Signals Layout | MV Screen 1+ | | Edit ) Layout [ MV Screen 2+ || Edit )
Standard: 1080i/59.94 Standard: 1080i/59.94
Multiviewer V Time: 0 lines V Tirne: 0 lines
H Time: 0 clocks ﬁ H Time: 0 clocks ﬁ
Control Points MV 3 | Multiviewer 3 MV 4 | Multiviewer 4
No Sources No Sources
Sois Lo Screen Not Active Screen Not Active
Layout | Mv Screen 3 Edit ) Layout | MV Screen 4 Edit )
Standard: 1080i/59.94 Standard: 1080i/59.94
V Time: 0 lines V Time: 0 lines
H Time: 0 clocks ﬁ H Time: 0 clocks ﬁ

MV164 example with 2 unallocated MV Units: 2 MV units allocated, 1 each to MV1 Output and to MV2
Output, leaving 2 MV Units unallocated and sitting in the MV Unit dock. Note that MV'1 and MV2 Screens
each indicate 4 Sources in bold, and MV3 and MV4 Screens each indicate No Sources in greyed out bold.
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Settings

General

Network

Ports
Timing & Genlock

Test Signals

Multiviewer

Control Points

External Control

Multiviewer
MV Units

MV 1 | Multiviewer 1

16 Sources
Screen Active

Layout | MV Screen 1+ || Edit )
Standard: 1080i/59.94

V Time: 0 lines

H Time: O clocks ﬁ

MV 3 | Multiviewer 3

No Sources
Screen Not Active

Layout | MV Screen 3

Edit )

Standard: 1080i/59.94
V Time: 0 lines
H Time: 0 clocks ﬁ

Drag MV Units (SRl ) between
Screens to allocate Multiviewer
resources. Each MV Unit provides 4
image cells and 2 data cells.

MV 2 | Multiviewer 2

No Sources
Screen Not Active

Layout | MV Screen 2 Edit )

Standard: 1080i/59.94
V Time: 0 lines
H Time: 0 clocks #

MV 4 | multiviewer 4

No Sources
Screen Not Active

Layout | MV Screen 4 Edit )
Standard: 1080i/59.94

V Time: 0 lines

H Time: 0 clocks #

MV164 16x1 example: 4 MV Units allocated to 1 MV Output (16 inputs to 1 outputs)

For this configuration, drag all 4 MV Units to 1 screen to have 16 sources available on one monitor.
Note MV'1 Screen indicates 16 Sources in bold, and MV2, 3 and 4 Screens indicate No Sources in greyed out bold.

—— MV164
e Settings > Multiviewer
General Multiviewer Drag MV Units (i) between
MV Units Screens to allocate Multiviewer
Network resources. Each MV Unit provides 4
image cells and 2 data cells.
Screens
Ports
- MV 1 | Multiviewer 1 — MV 2 | Multiviewer 2
Timing & Genlock 8 Sources Sources
- Screen Active 2en Active
Test Signals Layout [ MV Screen 1+ || Edit [ MvScreen1 ¢ || Edit)
Standard: 1080p ': 1080p
Multiviewer V Time: 0 lines lines
H Time: 0 clocks 'n. ~locks ¢
ContrOI POintS - MV 3 | Multiviewer 3 MV 4  Multiviewer 4
4 Sources No Sources
External Control Screen Active Screen Mot Active
Layout | MV Screen 3 ¢ || Edit 3 Layout | Quad Split Edit )
Standard: 1080p Standard: 1080p
V Time: 0 lines V Time: 0 lines
H Time: 0 clocks 'n. H Time: 0 clocks ﬁ

MV'164 8x4x4 example: 2 MV Units allocated to MV'1 Output, 1 MV Unit each allocated to MV2 and MV 3 Outputs.
For this configuration, drag 2 MV Units to MV'1 Output and 1 MV Unit each to MV2 and MV3 Outputs.

Note MV1 Screen indicates 8 Sources in bold, MV2 and MV3 Screens each indicate 4 Sources in bold, and MV4 Screen
indicates No Sources in greyed out bold.
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Selecting the Format for Each Multiviewer Output

Settings>Multiviewer MV Units Menu (continued)

Changing the Format and Output Timing for Each Screen - Click on the gear icon in each
Screen box to select a format and adjust the output timing.

Format - Select the Format that is compatible with the monitor for each output from 1080i
or 1080p.

Note that the Multiviewer frame rate is determined by the System Frame Rate which
is derived from the Standard of the Primary Test Signal Generator. This is set in the
Systems>Test Signals menu, detailed on page 20.

Vertical and Horizontal Timing - Adjust the vertical and horizontal output timing with

respect to the reference. Timing can be independently adjusted for each output.

MV164
Settings > Multiviewer

General Multiviewer Drag MV Units ([l between

MV Units Screens to allocate Multiviewer
Network resources. Each MV Unit provides 4
image cells and 2 data cells.
Screens
Ports _ : .
- MV 1 | Multiviewer 1 - MV 2 | Multiviewer 2
Timing & Genlock 4 Sources 4 Sources
Screen Active Screen Active
Test Signals Layout | Mv Screen 4+ || Edit ) Layout | Quad Split ~ + || Edit )
Standard: 1080p Standard: 1080p
Multiviewer V Time: 0 lines V Time: 0 lines
H Time: 0 clocks . H Time: 0 clocks 'ﬁ'
Format -
VIV 4 | Multiviewer 4
| 1080p
Sources
Frame Rate reen Active
Multiviewer frame rate is determined by the System Frame Rate, which is it | Quad Split + || Edit }
derived from the Standard of the Primary Test Signal Generator. ——
d: 1080p
Vertical Timing 0 lines
v @ [ oFie " clcks o
'
Horizontal Timing
Default 1) E@ clocks
- Big View X Delete Duplicate || Edit }
Kathleen X Delete Duplicate || Edit )
MV Screen 1 Layout X Delete Duplicate || Edit )
MV Screen 3 Layout X Delete Duplicate || Edit }
MV Screen 4 Layout (v 1] Delete Duplicate || Edit )
Qc1 *® Delete Duplicate || Edit )
Quad Split m m Delete Duplicate || Edit }

MV82 Settings>Multiviewer Menu: Frame Rate and Output Timing Selection for Screens
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Giving Your Inputs Custom Names

Settings>Ports Menu

Use this menu to give custom names to the Input Ports. Type names into the Name text boxes to the
right of the Input Ports and click Save Changes when finished. The custom names can then be easily
used for cell labels.

General Ports
Inputs
Network =~ Port Name
Input Port 1 | Camera 1

Ports | iputpen2

Input Port 3 |1n 3

Timing & Genlock
Input Port 4 |1n 4

Test Signals
Input Port 5 |In 5

Multiviewer

Input Port 6 |In6
i Input Port 7 [in 7
Control Points
Input Port 8 |In 8
External Control
Input Port 8 |Ing
Input Port 10 |In 10
Input Port 11 |1n 11
Input Port 12 |1n 12
Input Port 13 |1n 13
Input Port 14 | 1n 14
Input Port 15 |In 15

Input Port 26 |In 16

Test Signals
Port Name

Primary TSG |TsG 1
Secondary TSG | TsG 2

Outputs
Port Name

Output Port 1 |out 1
Output Port 2 | out 2

Output Port 3 | out 3

Qutput Port 4 |Qut 4

Settings>Ports Menu as seen on a web browser
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Selecting a Reference Source
Settings>Timing & Genlock Menu

Use this menu to select either Master Reference or Internal Reference as your Reference Source.

« Master Reference - If you have a reference signal connected to the Avenue Frame Master
Reference Input, select Master Reference from the Reference Source pulldown. This will enable
the output of the Multiviewer to be in time with house. The vertical and horizontal output
timing can be adjusted with respect to the reference in the Settings>Multiviewer>Screens
menu. Timing can be independently adjusted for each output.

» Internal Reference - Avenue Multiviewers do not require an external reference, and can
use their own internal precision reference generator. If you do not have a reference signal
connected to the Avenue Frame Master Reference Input, select Internal Reference from
the Reference Source pulldown. The vertical and horizontal output timing can be adjusted
with respect to the reference in the Settings>Multiviewer>Screens menu. Timing can be
independently adjusted for each output.

ﬁ Settings

General Timing & Genlock

Rafaranra Snurge Master Reference Status System Frame Rate
Network Internal
+ Master Ref , Ref 1080i/5994 TLS 23.98/29.97/59.94Hz External

System Frame Rate

Ports System Frame Rate is determined by the Standard of the Primary Test Signal Generator.
Multiviewer configuration must be in agreement with this setting.
Timing & Genlock
Test Signals
Multiviewer

Control Points

External Control

Settings>Timing & Genlock Menu as seen on a web browser
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Designing and Editing Multiviewer Outputs

Settings>Multiviewer>Layouts Menu

Once you have allocated your MV Units to the desired Multiviewer output(s) you can design your
Screen Layouts and Cell Styles. Click-to-fill configuration, snap-to grids and intuitive menus make setup
super-simple. Thumbnail proxies of the actual video inputs contribute to an easy and natural editing
experience. An unlimited number of layouts can be created offline. The layout editing window is so
accurate that one can design a layout without looking at the actual Multiviewer video output. Multiple
screen layouts can be created, saved, and easily recalled, or applied to other Multiviewer outputs. One
Multiviewer screen layout might be for a QC position while others could be created for a control room,
remote truck or producer position. New screen layouts can be designed while the Multiviewer hardware
is in use. Intuitive eyedropper and paste authoring tools make designing fast and straight-forward.

To go to Screen Layout Editing, click the Edit button associated with the Layout you want to work on.
To create a new Layout, type a name into the New Layout text box and hit the Create button.

ﬁ Settings

General Multiviewer

Drag MV Units (SRl ) between

MV Units Screens to allocate Multiviewer
Network resources. Each MV Unit provides 4
image cells and 2 data cells.
Screens
Ports
MV 1 | Multiviewer 1 MV 2 | Multiviewer 2
Timing & Genlock 16 Sources No Sources
Screen Active Screen Not Active
Test Signals Layout | M Screen 1+ || Edit ) Layout | MV Screen 2+ || Edit )
Standard: 1080i/59.94 Standard: 1080i/59.94
Multiviewer - V Time: 0 lines V Time: 0 lines
H Time: 0 clocks ﬁ H Time: 0 clocks ﬁ'
Control Points MV 3 Multiviewer 3 MV 4 Multiviewer 4
No Sources No Sources
External Conirol Screen Not Active Screen Not Active
Layout | MV Screen 3 ¢ || Edit Layout | MV Screen 4+ || Edit )
Standard: 1080i/59.94 Standard: 1080i/59.94
V Time: 0 lines V Time: 0 lines
H Time: 0 clocks ﬁ' H Time: 0 clocks ﬁ'
Layouts
Mew Layout Create
MV Screen 1 Layout ap Delete Duplicate || Edit )
MV Screen 2 Layout X Delete Duplicate || Edit )
MV Screen 3 Layout *® Delete Duplicate | Edi
—
MV Screen 4 Layout *® Delete Duplicate || Ec ﬂ

To go to Screen Layout Editing, click the Edit button associated with the Layout you want to work on. The oval blue
icons indicate the Layouts that are currently being routed to the outputs, and would therefore be on-line edits.
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Screen Layout Edit Menu
Settings>Multiviewer>Edit>MV Screen Menu

Screen Layout Edit is used to design and manage your Multiviewer output(s). First choose a 4x4 or 3x3
grid, then click-to-fill with your sources. The Multiviewer will initially auto fill with a variety of sources
as you click-to-fill. You may then select, change or remove sources. Internally generated test patterns,
clocks and timers are available in addition to the cabled video inputs. Favorite Screen Layouts can be
saved and easily recalled or applied to other Multiviewer outputs. Your Multiviewer comes with some

pre-set Screen Layouts and cell configurations to choose from, and of course, you can create your own,
everything is customizable.

) ~ Edi

Settings > Multiviewer > Edit > MV Screen 4 Layout

Givio) [T e st tovou | oo R oo Q0 s o)
Edit Default

This layout requires 1 MV Unit

LConfig >

Screen Layout Menu with a 4x4 grid, drawing in a new cell with the pencil tool
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Screen Layout: Control Descriptions

MV164
Settings > Multiviewer > Edit > MV Screen 2 Layout

s n @ | m Gell Style Name | MV Screen 2 Layout | Grid | 3x3 m Audio [ Off m Mosaic |
Default

Edit

This layout requires 1 MV Unit, and is active on (/A1

K7

@]

Screen Layout Menu Bar, Edit tools at the far left

Edit - The Edit portion of the menu bar is comprised of four tools used to create cells, copy
and paste Cell Styles, and to preview the Multiviewer output being edited. The Pencil,

Style Eyedropper, Paint Style and Preview tools are detailed below. These editing tools view
the cell configuration attributes in two categories, appearance and behavior, defined below to
clarify how the tools function.

Appearance Traits — Image size, Frames, Labels, Audio Meters, and Tally appearance.
Behavior Traits — Source, GPI/GPO settings, Alarms, Tally mode, and Tally source.

Pencil Tool- The Pencil tool creates cells from scratch. It draws whatever Cell Style is currently
represented by the Cell Style icon in the menu bar. Cells created with the Pencil tool will have
all of the appearance AND behavior traits of the Cell Style represented by the current icon. The
Pencil tool cannot draw over a cell that is already occupied, it can only draw onto vacant cells.

The Pencil tool retains a buffer and the Cell Style icon shows what's in the buffer. If, for
example, you use the Eyedropper tool to select a different cell (and therefore that cell’s Cell
Style), that Cell Style goes into the buffer and the icon changes to represent it. The Pencil tool
draws whatever Cell Style is in the icon, so for example, if you want to create several cells with
the same behavior traits, such as GPI/GPO settings, use the eyedropper to select a cell that
contains those settings, and then draw in new cells with the Pencil tool.

Style Eyedropper — The Eyedropper tool copies a Cell Style and puts it into the buffer. Click
the Eyedropper tool, and then click on the cell you want to copy. Although the Eyedropper
tool picks up all of the appearance traits and behavior traits of the copied Cell Style, what is
transferred to other cells depends on what tool you then edit with. When you edit with the
Pencil tool, all of the appearance AND behavior traits of the Cell Style represented by the
current icon are transferred to the new cell. When you edit with the Paintbrush the appearance
traits of the Cell Style represented by the current icon are transferred to the new cell, but not
the behavior traits of the copied cell.

Paint Style - The Paintbrush tool pastes in whatever Cell Style is currently represented by the
Cell Style icon in the menu bar. It paints down all appearance traits of that Cell Style, but not
the behavior traits. The Paintbrush tool paints over occupied cells and applies the new Cell
Style to them. The Paintbrush tool cannot create a new cell in an unoccupied cell space.

Preview - click the preview button to preview exactly what you will see on the SDI output.
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Screen Layout: Control Descriptions (continued)

» Cell Style - To populate cells, choose a Video Cell Style or Data Cell Style from the pulldown
menu, then use the Pencil and/or Paint Style tools to populate cells. Please refer to the
previous page for details on using these tools. As you click-to-fill, cells will be formatted in the
Cell Style that is currently represented by the Cell Style icon. Use the Cell Style pulldown menu,
or the Style Eyedropper tool to select a different Cell Style.

To further customize cells, click the Config button in the lower right hand corner of the cell to
access all of the Cell Configuration menus. From there you can fully customize the cell, and
save those modifications as a new Cell Style if desired. If you do not save the changes as a new
Cell Style, then the edits made will effect the edited cell only.

Deleting Cells - To delete a cell, click the red X in the upper left hand corner of the cell. The
cell can then be repopulated with the Pencil tool.

Applying a Different Cell Style to a Populated Cell — Choose the Cell Style you want to
apply from the Cell Style pulldown menu or use the Style Eyedropper tool copy the desired
Cell Style from another populated cell. Your desired Cell Style will now appear as the Cell Style
icon. Select the Paint Style tool and click on the cell you want to apply the Cell Style to. The
Paintbrush tool paints over the occupied cell and applies the appearance traits of the new
Cell Style to it. It will not change the Video Source or the other behavioral traits of the cell.

ﬁ Multiviewer > MV Screen 4 Layout

@ islo) [ | v s o | oo R son [0 s

Edit
This layout requires 1 M\ﬂ Video Styles ]

I:. Blue 85
_. Default
I_. Game Room
L. Pich 1
g PRGM/PVW

Data Styles

- Default Clock

Screen Layout Menu using a 4x4 grid, showing a quad split, with Cell Style pulldown detail, in Edit Mode
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Screen Layout: Control Descriptions (continued)

Creating New Cell Styles — To create a new Cell Style, click the Config button in the lower
right hand corner of the cell, this will take you to the Cell Configuration menus. Design and
save your Cell Style there. It will then be available in the Cell Style pulldown choices. See the
Cell Configuration section of this manual for complete details.

Deleting Cell Styles To delete a Cell Style, click the Config button in the lower right hand
corner of the cell, this will take you to the Cell Configuration menus. Click the Cell Style button
and select Manage Cell Styles from the pulldown menu. Delete Cell Styles as desired.

« Name -Type in a custom name for the Layout, if desired.

»  Grid - Choose a 4x4 or 3x3 grid. The grid architecture ensures perfect alignment of your
sources. This is the first step in the Screen Layout process.

« Source - In the upper right hand corner of each cell, choose or change your source from the
pulldown menu.

« Config - Clicking the Config button located in the lower right hand corner of each cell takes
you to Cell Style Configuration menus for that cell. See the Cell Configuration section of this
manual for complete details.

« Done -When you have completed your Screen Layout, click the Done button located in the
upper left hand corner of the screen. This will return you to the Settings>Multiviewer menu.

Deleting a Layout — To delete a Layout, click the Done button which will return you to

the Settings>Multiviewer menu. In the Layout section you can delete Layouts that are not
currently being routed to a Multiviewer output.

www.ensembledesigns.com MV82 and MV164 - page 36



Avenue Multiviewers, Models MV82 and MV164

Screen Layout: Control Descriptions (continued)

» Audio - Choose Off, Solo or Mosaic to manage the audio on the Multiviewer output
as follows:

Off — No audio will be embedded on the output.

Solo - Choosing Solo in this menu turns on the solo buttons in the MV Control window, and
therefore enables an operator with Control privileges to select the audio source that will be
embedded in the output. If no Control authorization is given, the default for Solo will embed
channels 1 and 2 of the first cell drawn in the layout into channels 1 and 2 of the output.

Mosaic - The SDI output can have up to 16 channels (8 pairs) of embedded audio, two
channels from each of up to 8 sources. Mosaic takes channels 1 and 2 from every cell and
puts them into up to 16 channels of the output. Select the channels desired for each source
with the blue channel button in the lower left had corner of the source’s cell. Use Mosaic
mode when you want audio from multiple sources on your Multiviewer output. When there
are multiple channels embedded on the SDI output, some consumer monitors, or a monitor
outfitted with a BrightEye 72, will allow you to select two channels to listen to.

MV164
ﬁ Settings > Multiviewer > Edit > Quad Split

AT o [5 TTR PO TREE .. PR .

This layout requires 1 MV Unit, and is active on (.70 {170

Screen Layout Menu, using a 4x4 grid, with Audio Mosaic detail, in Preview Mode
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Screen Layout: User Interface Notices Regarding Available and Needed Resources

When editing, a message will appear in the menu bar indicating how many MV Units are required for
the Layout. If you are editing on-line, the notice will also indicate what output(s) the Layout is active
on, and if you are attempting to populate cells using more resources than are currently allocated to
the output(s). To assist visually with the editing process, the layout screen may show sources even if
you do not have enough sources allocated. On the output the unavailable sources will not show. When
you assign currently unavailable sources, the user interface will show a warning over each cell that
does not have a source available. An example of this is shown in the lower right hand cell of the below
illustration. To reallocate resources go to the Settings>Multiviewer> MV Screens menu.

When editing off-line, you can author using as many sources as you like, and the user interface will
indicate how many MV Units are needed for the Layout. This allows editing layouts without effecting
an output, while still being able to see exactly what they will look like, even without sources available
during the editing process. When off-line editing is complete, Layouts can be applied to the desired
output(s) without loss of sync.

MV1 64
E Settings > Multiviewer > Edit > Big View

’ u ® _ CallShis Name | Big View | Grid —
Edit i -
R

This layout requires 3 MV Units, and is active on

G IEna 3 (g Source: _—
—— SOUrCE: In2 ( source: In 3

N — ——

_.."_:; ‘?f‘r ' ¥

‘E:h/’cormg b3 A I.rurmq b

st —

Q Source: In 4 " ’ “ Source: In5 -
-~

f
~D

Conhg > Y . Config
v

fisible On ~ MV1

c——

Config _ Config ) Config

This example shows a Layout being edited on-line that requires 9 video sources in order to display accurately
on the output. The red warning in the menu bar indicates that not enough MV Units are currently allocated
to the MV1 output to provide 9 video sources. The cell in the lower right hand corner shows the notice “Not
Visible On MV1” because there is no source available for that cell. To reallocate MV Units, click the Done
button to return to the Settings>Multiviewer Menu, and drag the needed MV units to the MV'1 screen.
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MV164
@ Settings > Multiviewer > Edit > Big View

, R wame [ Big View | o D
Edit ] :

This layout requires 4 MV Units, and is active on

e gurce: In 1 — |x| ~
e I
e P

ECHE Eeasth
s _‘ﬁ Co"“q_) " Config »

Soureet In 5

Confi
Config )
S Source: In 9 — . ».9 In" 11"y Source: In12 '
Mot Visible On = MV1 i NO ible On MV . _ Not Visible On M1
. A

e
—

T X y il _ - -~ : Co
Config ) : i Config »

e In13 5 n 14 B Source: In 15 ( : Inl6 'y

2 0n - MV 4 No . =4 Not Visible On ' nv1 Mot Visible On - MV
~ . ‘ : CTTTTTIIT
.

O

Config 3 = "h Config * fin16 | Config )
This example shows a Layout being edited on-line that requires 16 video sources in order to display
accurately on the output. The red warning in the menu bar indicates that not enough MV Units are currently
allocated to the MV1 output to provide 16 video sources. To reallocate MV units, click the Done button to
return to the Settings>Multiviewer Menu, and drag the needed MV units to the MV1 screen.

Layouts that are not currently being routed to an MV output may be edited off -line using as many
sources as desired. This allows editing of layouts without effecting an output, while still being able to see
exactly what they will look like, even without sources available during the editing process. When editing is
complete, Layouts can be applied to the desired output(s) without loss of sync.
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Cell Style Configuration

Cell Style Configuration is where each Cell Style is designed. Image size, labels, frames, borders, audio
metering, alarms, clocks, timers and tally are all customizable. Video can fill the cell or be held back

at 85% with a border on the sides and bottom. When 85% is selected, you'll see a visual separation
and space for audio meters and labeling information. Labels can appear over the video with no
background, with a full width with the background color behind them, or with a background fit to the
text. Transparency of the label background is completely adjustable, and label position can be in the
upper left, upper right, or centered at the bottom. The matte color tool is used to select background,
frame and label color and transparency. When the frame is on, the picture is scaled so no pixels are
covered by the surrounding border. The frame can be set to thick, medium or thin. Up to four groups
of audio meters can be displayed, with fast or slow peak display response. Two sets of Tallys can be set.
Tally can be indicated with a frame, a label, or both. The frame color, label color, and label background
colors for tally can all be customized. Extensive alarming options are available and can be indicated in
a variety of ways on-screen, or used to trigger GPO alarms. Alarm monitoring includes loss of signal,
freeze, black, and specific audio parameters. Cell styles can be saved and easily applied to other cells.

Details and example for each menu of Cell Style Configuration are in the following section. No

matter what Cell Style menu you're in (General, Audio, etc.), the Source and Cell Style controls will be
available, and the Done button will be in the upper left hand corner. Use the Source pulldown control
to select or change the source for the cell. Use the Cell Style control to save, recall, and apply Cell Styles
to the cell. Use the Done button to save changes and return to Screen Layout.

To begin editing a cell, from The Screen Layout menu, click the Config button of the desired cell. This
will take you to the Cell Configuration menus for that cell.

MV164
ﬁ Settings > Multiviewer > Edit > MV Screen 2 Layout

ﬂ FaE 2K -2 : !““S'Y“ | Mame | MV Screen 2 Layout wu@ Audio | OFf Mosaic |
Edn Default

This layout requires 1 MV Unit, and is active on {170

Source: m

Config p

Program Config

San Francisco ' Denver

- 4:28:31 5:28:31

\
Z Config p Config p Config
K. L AT fl

To go to the Cell Configuration menus click the Config button of the desired cell
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» Source —To change the video source of the cell, click on the Source button and select a source
from the pulldown.

E g MV Screen 1 Layout > Cell 2
In 4
ur Cell Style...
In7

In8

In9

In 10
In 11
In 12
In 13
In 14
In 15
In 16
T5G 1
TSC 2

m Frame ‘ Label ‘ Tally 1 ‘ Tally 2 ‘ Audio ‘ Alarms

Image Size Background Color SD Aspect Ratio
(mBull (sk:3n
GPI Fullscreen GPI Audio Solo
GPI GPI
|_| Enabled B! 3| |_| Enabled L1

Cell Style Configuration: Source detail
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» Cell Style - You can save your favorite Cell Styles which can then be applied to other cells.

To Save a Style - Set up cell parameters as desired, click Cell Style, then chose Save As New
Cell Style, and type in a name. The new Cell Style will now show up in the Cell Style list in
Screen layout menu bar.

To Remove Cell Styles - Click Cell Style, then chose Manage Cell Styles, and delete unwanted
Cell Styles as desired.

ﬁ MV Screen 1 Layout > Cell 2

Soumei In7 |:J Cell sqle...

Save As New Cell Style...

Apply Style:
4U
P

L ™
_. Default

L' Game Room
L |

Manage Cell Styles...

m Frame ‘ Label ‘ Tally 1 | Tally 2 ‘ Audio ‘ AIarmsJ

Image Size Background Color SD Aspect Ratio
| 85% | . | 43 |
GPI Fullscreen GPI Audio Solo
GPI GPI

[ Enabled [ 1 s [_ Enabled |1

Cell Style Configuration: Cell Style detail
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Cell Style Configuration: General Menu

The Cell Style Configuration General menu allows you to chose the image size in the cell, the
background color of the cell, and the SD aspect ratio when the cell’s input is an SD source.

» Image Size - Set the Image Size to Full or 85% as follows:
Full — Choose Full to fill the entire cell with the picture content (within the constraints of
the aspect ratio). In this mode audio meters and labeling will lay over the top of the picture

content.

85% — Choose 85% to have labels and audio meters separate from the video content. When
85% is selected, the full video content is retained and the image is scaled.

See the following page for several examples of image size with and without labels and audio meters.

General

Image Size Background Color 5D Aspect Ratio Closed Captions
] (43 5 (on
GPI Fullscreen GPI Audio Solo
GPI GPI
| Enabled [1 > | Enabled (sl

Cell Style Configuration: Image Size: Full
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Image Size: Examples for 85% and Full, with and without Audio Meters and Labels

Cell Style Configuration:
Image Size: Full

Cell Style Configuration:
Image Size: Full, with Audio Meters
and a Label

Cell Style Configuration:
Image Size: 85%

Cell Style Configuration:
Image Size: 85%, with Audio Meters
and a Label
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Cell Style Configuration: General Menu (continued)

» Background Color - When the image size is 85% there will be a background. Select the
background color for the cell by clicking on the Background Color box. A color wheel will pop
up so you can select an exact custom color. To save your favorite colors, use the palette squares
to the far right. The palette squares will auto fill with the currently selected color and can then
be used for quick recall.

« SD Aspect Ratio — This control only applies if the cell’s source is SD. The selection will
determine how to display the SD image. Choose from 4:3 or 16:9 as follows:

16:9 - If the SD material was shot with an anamorphic lens, then 16:9 will look correct,
maintaining proper aspect ratio, and the image will fill the cell.

4:3 - If the SD source is 4:3, as it generally is, the 4:3 setting will maintain proper aspect ratio
and the picture will be pillar boxed in the cell.

done | MV Screen 1 Layout > Cell 2

Source LInE |:j [c.:u style... J

m Frame ‘ Label ‘ Tally 1 ‘ Tally 2 ‘ Audio ‘ A]armsJ

Image Size Background Color SD Aspect Ratio Closed Captions

(5% :) (43 ™| [off

¢ . GPI Audio Solo

("] Enabled

GPI

Cell Style Configuration: Background Color detail
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Cell Style Configuration: General Menu (continued)

+ Closed Captions - Select from Off, CEA 608 CC1, CEA 608 CC2, CEA 708 DTVCC1,
CEA 708 DTVCC2.

Choose 608 for Line 21 style of captions. CC1 refers to service 1, which generally carries the
primary language. CC2 refers to service 2, which often carries a secondary language.

Mv82
@ MYV Screen 2 Layout > Cell 1

Source [ In1 #J [ Cell Style... J

m Frame ‘ Label ‘ Tally 1 ‘ Tally 2 ‘ Audio ‘ Alarms ’

Image Size Background Color SD Aspect Ratio Closed Captions
| Full ol . | 16:9 2l
CEA 608 CC1
GPI Fullscreen GPI Audio Solo CEA 605 CC2
CEA 708 DTVCC1
GPI CEA 708 DTVCC2
[ Enabled [1 v [ Enabled - <)

Cell Style Configuration: Closed Caption detail
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Cell Style Configuration: General Menu (continued)

o GPI Fullscreen - Allows enabling an external GPI to take the cell to fullscreen on the output.
To enable a GPI that will trigger this cell to fullscreen, check the GPI Fullscreen Enabled box
and select the GPI pin from the pulldown.

» GPI Audio Solo - To enable a GPI that will trigger this cell for Audio Solo, check the GPI Audio
Solo Enabled box and select the GPI pin from the pulldown.

Note: A third party device, such as the eBox from JL Cooper, is required to use GPI's. GPI pins must also
be enabled in the Settings>External Control menu in order to be accessible in this menu. If the GPI pin
selections are greyed out, as shown in the GPI Fullscreen pulldown below, go to the Settings>External
Control menu to enable them on a pin by pin basis as desired.

E MV Screen 1 Layout > Cell 3

Source[ In4 :J | Cell Style... |

m Frame ‘ Label ‘ Tally 1 ‘ Tally 2 ‘ Audio ‘ Alarms

Image Size Background Color SD Aspect Ratio Closed Captions
B85% - 4:3 = off
GPI Fullscreen GPI Audio Solo
MV GPl's GPI
Non-MV GPI's
™ Enabled 1 Enabled 1
2
3
4
5
6
8
9
0

Cell Style Configuration: GPI Fullscreen detail
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Cell Style Configuration: Frame Menu

The Frame Config menu allows you to turn a frame On or Off, chose a thick, medium or thin frame,
and select the frame color as follows:

o Frame - Check the Enabled box to put a frame around the video content. When the frame is
enabled the full video content is retained. The image is scaled properly scaled so no pixels are
covered by the frame.

« Frame Size -Select a thin, medium or thick frame.
» Frame Color - Select the frame color for the cell by clicking on the Frame Color box. A color
wheel will pop up so you can select an exact custom color. Select a color on the color wheel,

then select the specific color from the square box inside the wheel. Save favorite colors in the
palette squares to the far right for easy recall.

“pone | MV Screen 1 Layout > Cell 3

30uree[ln1 |:] [Ceus:yle...J

General Im Label ‘ Tally 1 ‘ Tally 2 ‘ Audio ‘ Alarms |

Frame Frame Size Frame Color

& Enabled [ Thin - .

Cell Style Configuration: Image Size Full, Frame Size Thin
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“pone | MV Screen 1 Layout > Cell 3

sowrce [In1+] | cell style... |

| General R wabel [ Tally 1 | Tally 2 | Audio | Alarms

Frame Frame Size Frame Color

™ Enabled | Thick :

-

HEman | |

Cell Style Configuration: Image Size 85%, Frame Size Thick (shown in white),
Frame Color detail
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Cell Style Configuration: Label Menu

» Enabled - Check the Enabled box to create a Cell Label. You can then change the label position,
color of the text, color, width, and transparency of the label background, and the select small or
large text size.

o Source - Select the Source for the Label from the pulldown. Choose Port Name, Custom or
External. External gear can drive the name of the label.

e Custom Label - When Custom is selected in Label Source, use the Custom Label Box to type in
your Cell Label.

» Position - Choose the position for the label from Upper Left, Upper Right and
Bottom Center.

» Size - Select the size of the label text from Small or Large.

“pone | MV Screen 1 Layout > Cell 9

souce [ ms 3| | cell suye... |

| Generat | Frame [ vty 1 [ Tally 2 | Audio | Alarms |

Source Custom Label Pneitinn
Upper Left
o Enabled (custom 2] [cam3
Bottom Center
Size Color Background Background Color

[ Small s D [FittoText  # | .

Cell Style Configuration: Label Menu: Position detail
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Cell Style Configuration: Label Menu (continued)

» Color - Select the text color for the label text by clicking on the Color box. A color wheel will
pop up so you can select an exact custom color. Use the transparency bar to the right of the
color wheel to adjust the transparency of the text. Save favorite colors in the palette squares to
the far right for easy recall.

» Background - Select from Off, Fit to Text, or Full Width. Off gives you a label with no
background. Full Width puts a background behind the label that is the full width of the cell,
and Fit to Text puts a background behind the label that is slightly wider than the text.

» Background Color - Select the color for the label background by clicking on the Background
Color box. A color wheel will pop up so you can select your exact custom color. Use the
transparency bar to the right of the color wheel to adjust the transparency of the label
background. Save favorite colors in the palette squares to the far right for easy recall.

"pone | MV Screen 1 Layout > Cell 3

Source E In 15 3i Cell Sgle...

_
— e — -

Fiemote

Source Custom Label Position

™ Enabled | Custom | Remote | | Bottom Cente % |
Size Color Background Background Color

OO0 NER 53

| Large = D | Full width :

Cell Style Configuration: Label Background, Text Color detail
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Cell Style Configuration: Tally Menus

Two levels of tally give you full confidence of which sources are active on air. Tally can be independently
assigned to different elements in the makeup of the cell: frame color, label text, and label background.
To use Tally, you'll need a third party GPI device, such as the eBox from JL Cooper.

Menus for Tally 1 and Tally 2 operate in the same way. Tally 1 is shown below. If both Tally 1 and Tally 2
are active at the same time, Tally 1 has priority and draws over Tally 2.

» Preview - Once you have set up the Tally as desired, click the Preview button to see what the cell
will look like when the Tally is active. Preview works on this screen, and on the output monitor if
you are routed to an output.

»  GPITally - Check the Enabled box in order to use the Tally, then select the desired pin from the
pulldown menu. GPI pins must also be enabled in the Settings>External Control menu in order
to be accessible in this menu. If the GPI pin selections are greyed out, go to the Settings>External
Control menu to enable them on a pin by pin basis as desired. Note that in the example below
pins 1-4 have been enabled in the Settings>External Control menu.

MVB2
ﬁ MV Screen 2 Layout > Cell 4

Souroeilnti |:] [Ceus:yl_e...J

[General Frame | Label Tally 2 ‘ Audio ‘ Alarms |
GPI Tally
GPI
Preview ™ Enabled [ |
2
3
Frame 4
Color 3 Color
6 —
o Enabled . 7
8 = -}
9
Label Background 10

12
# Enabled . 13

Cell Style Configuration: Tally 1 GPI Tally detail.
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Cell Style Configuration: Tally Menus (continued)

Frame - To select a frame around the video for Tally 1, check the Frame Enabled box. Then
select the frame color by clicking on the Color box. A color wheel will pop up so you can select
an exact custom color. Save favorite colors in the palette squares to the right of the color
wheel for easy recall.

Label Text - Label text is created in the Label menu. To show the label for Tally 1, check the
Label Text Enabled box. Then select the color you would like the label text to turn when

Tally 1 is activated by clicking the Color box. A color wheel will pop up so you can select your
exact custom color. Use the transparency bar to the right of the color wheel to adjust the
transparency of the label text. Save favorite colors in the palette squares to the far right for
easy recall.

Label Background - Add a background behind the label if desired. To do so, check the
Enabled box. Then select the color you would like the label background to turn when

Tally 1 is activated by clicking the Color box. A color wheel will pop up so you can select an
exact custom color. Use the transparency bar to the right of the color wheel to adjust the
transparency of the label background. Save favorite colors in the palette squares to the far
right for easy recall.

MIV164
m Morning Show > Cell 4

Label Tally 2 J Audio Lmarm; J

[__F.en.er_al J Frame

GPI Tally
GPI
Preview || Enabled =
Frame Label Text
Color Color

# Enabled . "] Enabled D

Label Background

| Enabled D

Cell Style Configuration: Tally T Menu shown in Preview mode
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Cell Style Configuration: Audio Menu

Use the Audio menu to turn audio meters On or Off, to choose which audio groups to display, set
reference level and to choose a fast or slow peak display as follows:

o Audio Meters — Turn audio meters Off, or select 1 Group, 2 Groups or 4 Groups. The
illustrations on the following page provide detailed information regarding where the audio
meters are located for each selection.

o Ref Level - Select the audio reference level as either -20dBFS or -18dBFS.

» Peak Display - Select from Off, Fast or Slow.

“done | MV Screen 1 Layout > Cell 9

source[mo 4] | cell swye... |

| General | Frame | Label | Tally 1 | Tally 2.

Audio Meters Raf | aual Peak Display
-18dBFS

| 2 Groups il v -20dBFS ) | Slow el

Cell Style Configuration: Audio Menu: Reference Level detail
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Audio Meter Positioning: Examples for 1 Group, 2 Groups and 4 Groups displayed

Cell Style Configuration: Audio Menu: Audio Meters detail, 1 Group

Cell Style Configuration: Audio Menu: Audio Meters detail, 2 Groups

Cell Style Configuration: Audio Menu: Audio Meters detail, 4 Groups
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Cell Style Configuration: Alarms Menu

Use the Alarms menu to turn alarms On or Off, and to set alarm parameters.

e Enabled - Check the Enabled box to turn the selected Alarms ON. No alarms will be active it

this box is not checked. For an alarm to report, an On Screen Alarm must be selected or
a GPO.

Note: A third party device, such as the eBox from JL Cooper, is required to use GPO'’s. GPO pins must
also be enabled in the Settings>External Control menu in order to be accessible in this menu. If the
GPI pin selections are greyed out, go to the Settings>External Control menu to enable them on a pin
by pin basis as desired.

MV164
E MV Screen 4 Layout > Cell 1

SaureeLlnl |¢J [ Cell Style.... ]

General ‘ Frame ‘ Label ‘ Tally 1 ‘ Tally 2 ‘ Audio m

GPI Alarm Clear
Alarms On Screen Alarm GPI
# Enabled | Persistent | || Enabled |1
GPO Alarm Loss of Signal
Mode GPO
| off + | |k 3 ™ Enabled 5| seconds
Black Freeze
™ Enabled 5| seconds ™ Enabled 5| seconds
Audio
Threshhold
@ Enabled | -40 dBFs = 5| seconds
Monitor Channels
Mi2@adaOs506 070809010011 012013014 015186

Cell Style Configuration: Alarms Menu
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Cell Style Configuration: Alarms Menu (continued)

« On Screen Alarm - When a fault is detected, an on-screen display of the Alarm notice will
show on the Multiviewer output and on Multiviewer Control windows. The Alarm notice is
a rectangular overlay with text and a border. It displays over the video of the faulted cell.
The display details and duration of Alarm notices vary based on the selection of Off, On, or
Persistent, as described below.

Off — There will be no on-screen display when a fault is detected.

On - When a fault is detected an Alarm notice will appear over the faulted cell. When the
condition clears, the Alarm notice goes away.

Persistent - When a fault is detected, an Alarm notice with a red border will appear over the
faulted cell. When the condition goes away, a notice with a yellow border will display, showing
that the fault is cleared and indicating the history of the fault. This window will stay displayed
over the video of the cell until it is cleared in the Multiviewer Control window, or cleared by
GPI. For an operator to be able to clear an alarm in the Multiviewer Control window, the

MV output must be enabled for Control in the Settings>Control Points menu.

Layout | M1 :

Fault
Video: Frozen
Audic: OK

i

San Francisco

02:29:59

Multiviewer Control window showing a Fault Alarm in the Cell for DDR 4
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Layout | MV.1 :

Cleared
Video was: Frozen
Audio was: OK

San Francisco San Francisco

02:31:01 02:31:01

Multiviewer Control window showing a Fault Cleared Notice in the Cell for DDR 4

Fault

Video: Frozen
Audio: OK

. Fullscreen |

Cell close-up of Fault Alarm message

Cleared

Video was: Frozen
Audio was: OK

. Fullscreen |

Cell close-up of Fault Cleared Notice
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Cell Style Configuration: Alarms Menu (continued)

GPI Alarm Clear - To clear an alarm via GPI, check the Enabled box in the GPI Alarm Clear
control and select the pin from the GPI pulldown. A third party device, such as the eBox from
JL Cooper, is required to use GPI's. GPI pins must also be enabled in the Settings>External
Control menu in order to be accessible in this menu. If the GPI pin selections are greyed out,
go to the Settings>External Control menu to enable them on a pin by pin basis as desired.

GPO Alarm - To trigger an alarm via GPO, select On, Pulse or Persistent from the Mode control
as described below, and select the trigger pin from the GPO pulldown. Note that a third party
device, such as the eBox from JL Cooper, is required to use GPO’s. GPO pins must also be
enabled in the Settings>External Control menu in order to be accessible in this menu. If the
GPO pin selections are greyed out, go to the Settings>External Control menu to enable them
on a pin by pin basis as desired.:

Off — GPO Alarm is Off.

On - The GPO will be asserted during the alarm fault condition. GPO will de-assert when the
fault condition is gone.

Pulse - This is momentary assertion when the alarm initiates, and could be used, for example,
for a bell or a beeper. The GPO will be asserted for 1 second every time a fault condition

begins. After 1 second the GPO will de-assert.

Persistent — The GPO will be asserted when a fault condition begins and will stay asserted
until cleared by an operator in an enabled MV Control window, or by a GPI.

Loss of Signal - Click the Enabled check box to enable the test for loss of the video signal.

Loss of Signal Timer - Select the amount of time in seconds that the signal must be
continuously lost before the alarm is generated.

Black - Click the Enabled check box to enable the test for black detection. The signal is
considered to be ‘black’if at least 95% of the pixels are black.

Black Timer - Select the amount of time in seconds that the signal must be continuously
black before the alarm is generated.

Freeze - Click the Enabled check box to enable the test for freeze detection.

Freeze Timer - Set the amount of time in seconds that the signal must be continuously frozen
before the alarm is generated.
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Cell Style Configuration: Alarms Menu (continued)

Audio - Click the Enabled check box to enable the test for silence detection.
Threshold - Select the silence detection level from -30 dBFS to -60 dBFS in 5 VU increments.

Note: dBFS stands for decibels Below Full Scale (Full Scale being the numerically largest
sample value that the audio path can represent). Because we are always describing the level
as being‘less than' this reference, the numbers are always negative. 0 dBFS is Full Scale and
is the loudest value possible. Thus, -30 dBFS is quieter than -20 dBFS. The nominal level of a
reference tone is -20 dBFS. Typical audio content will have peaks in the -5 to -10 dBFS range,
with average levels around -25 dBFS, so a typical threshold setting would be -40 dBFS.

Silence Timer - Set the time that one or more of the channels being monitored must be
continuously silent before an alarm is generated.

Monitor Channels - Select the audio channels to be monitored. If the audio falls below the
threshold for the allocated amount of time on ANY of the audio channels being monitored, the
alarm will trigger.
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Data Cell Style Configuration: General Menu

Use the Data Cell General menu to select the type of Data Cell you would like to create, and the
background color for the Data Cell as follows:

» Type - Select the type of Data Cell you would like to create from Clock, Label or Timer.
The available tabs and menus will vary according to the type of Data Call selected.

» Background Color - Select the background color for the Data Cell using the color wheel.
Select a color on the color wheel, then select the specific color from the square box inside the
wheel. Save favorite colors in the boxes to the right of the wheel, click boxes to quickly
recall color.

MvB2
ﬁ MV Screen 2 Layout > Data Cell 1

|' Cell style... |

San Francisco

07:19:24

Type Background Color

v Clock INTP)  } ] -
Label

Timer

Label | Clock |

Data Cell Style Configuration: General menu, Type detail
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Data Cell Style Configuration: Frame Menu

Use the Frame menu to add a frame around the data. Choose a thin, medium or think frame and select
the frame color.

» Frame -To add a frame around the data, check the Frame Enabled box.

» Frame Size - Select a thin, medium or think frame.

» Frame Color - Select the frame color using the color wheel. Select a color on the color wheel,
then select the specific color from the square box inside the wheel. Save favorite colors in the
boxes to the right of the wheel, click boxes to quickly recall color.

» Interior Color — Select the interior color using the color wheel. Select a color on the color

wheel, then select the specific color from the square box inside the wheel. Save favorite colors
in the boxes to the right of the wheel, click boxes to quickly recall color.

"pone | MV Screen 1 Layout > Data Cell 1

Cell Style...

San Francisco

04:53:21

o [ oo s

Frame Frama Sira Frame Color Interior Color
Thin
o Enabled [ vedum —— IS | B

Data Cell Style Configuration: Frame menu, Frame Size detail
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Data Cell Style Configuration: Label Menu

Use the Label menu to add a custom label to a Clock or Timer Data Cell and to and to select the color
of the label text. For Label Data Cells, two lines of text will be available. Each line can have small or
large text and a unique color.

« Enabled - To add a custom text label, check the Enabled box.

« Text - Type your label text here. For Label Data Cells, two lines of text will be available. Each
line can have small or large text and a unique color.

Note: We recommended previewing Data cells that include labels in order to verify that the
text entered will fit. To Preview, click the Done button in the upper left hand corner of each
screen until you get to a Control Window. From the Control Window you can select and view
available layouts.

MVB2
E MV Screen 2 Layout > Data Cell 1

|' Cell Style.... |

Pittsburgh

| General m Label

Line 1
Size Text Color
™ Enabled Small L Pittsburgh
Line 2
Size Text Color
# Enabled Large : Pennsylvania .

Data Cell Style Configuration: Label menu for a Label Data Cell
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Data Cell Style Configuration: Label Menu (continued)

o Color - Select the color of the label text using the color wheel. Select a color on the
color wheel, then select the specific color from the square box inside the wheel. Use the
transparency bar to the right of the color wheel to adjust the transparency of the label
background. Save favorite colors in the boxes to the right of the wheel, click boxes to quickly
recall color.

"pone | MV Screen 1 Layout > Data Cell 1

Cell Style...

03:17:15

( General | Frame Clock |
| General | rrame [FEETY ciock |

Text Color

EI Enabled [ New York

mHEmas | | b

’:

Data Cell Style Configuration: Label menu for a Clock Data Cell, Color detail
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Data Cell Style Configuration: Clock Menu

Use the Clock menu to select the time zone of the clock, to chose a 12 Hour or 24 Hour clock display,
and to select the color of the clock display as follows:

o Time Zone - Choose the time zone for the clock from the pulldown menu. Clocks will calculate
the time automatically and account for daylight savings time. The pulldown menu includes
regions in addition to time zones in order to address variations in daylight savings.

o Hour Display - Select from a 12 Hour or 24 Hour clock display. For example, 1:15pm will
display as 01:15:00 with a 12 Hour display and as 13:15:00 with a 24 hour display.

» Color - Select the color of the clock display using the color wheel. Select a color on the color

wheel, then select the specific color from the square box inside the wheel. Save favorite colors
in the boxes to the right of the wheel, click boxes to quickly recall color.

MVE2
E MV Screen 2 Layout > Data Cell 1

| cell style... |

General ‘ Frame ‘ Label m

Time Zone Hour Display Color

(UTC -07:00) Mountain Time (US & Canat * + 12 Hour _I

24 Hour

Data Cell Style Configuration: Clock menu, Hour Display detail
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Data Cell Style Configuration: Timer Menu

Use the Timer menu to select the time zone of the timer on a cell by cell basis, to select a custom

color for the timer, and to chose a 12 Hour or 24 Hour Display style. Up to 8 timers can be used
simultaneously in different cells by selecting a unique timer for each timer cell (Timer 1- Timer 8).
Different cells can be based on different time zones. From a Control window, operators can select from
three types of timers: Time Up, Time Down or Time Until. See the Operations section of this manual for
complete details on using the Timers from a Control window.

Done

Timer 1
Timer 2

Timer 4

Timer 5
Timer 6
Timer 7
Timer 8

T

((1uTc +03:00) Seoul 3) (12 Hour D)

Hour Display

Data Cell Style Configuration: Timer menu, unique Timer selection detail

+ Time Up '
Time Down
Tirme Until

Detail of Timer Cell in a Control Window
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Data Cell Style Configuration: Timer Menu (continued)

» Time Zone - Choose the time zone for the Timer clock to be based on. Unique time zones may
be assigned on a cell by cell basis for multiple timers. The Timer clock will calculate the time
automatically and account for daylight savings time. The pulldown menu includes regions in
addition to time zones in order to address variations in daylight savings time.

« Timer - Up to 8 timers can be used simultaneously in different cells. Select Timer 1 - Timer 8
from the pulldown menu to assign unique timers to each Timer cell.

» Color - Select the color of the timer display using the color wheel. Select a color on the color
wheel, then select the specific color from the square box inside the wheel. Save favorite colors

in the boxes to the right of the wheel, click boxes to quickly recall color.

» Hour Display - Select from a 12 Hour or 24 Hour clock display. For example, 1:15pm will
display as 01:15:00 with a 12 Hour display and as 13:15:00 with a 24 hour display.
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Operating the Multiviewer

Multiviewer Control Windows

Multiviewer Control windows can provide operators monitoring and some control, without allowing
editing. From a fully enabled Multiviewer Control window, operators can take any of the sources on
the Multiviewer output to fullscreen, select the audio channel for output, select a different Screen
Layout (which may have completely different sources), run timers, and clear alarm notices. How these
controls are available is determined in the Multiviewer Screen Layout and Cell Configuration Editing
process. Multiviewer access may be operator only (non-editing) by enabling an Admin password in the
Settings>General>Security menu.

Navigating to Multiviewer Control Windows: When you're finished editing, click the Done button to
exit out of the editing menus, this will return you to Settings>Multiviewer. Click the Done button to exit,
this will take you to the root menu shown below. Click the box in the upper let hand corner and select
the Multiviewer Control window you would like to control.

The following controls can be provided to operators, on a output by output basis. To enable these
Controls, the desired MV output(s) must be enabled in the Settings>Control Points menu.

«  Full Screen - Click the Fullscreen button in a cell to bring that input to fullscreen on the
Multiviewer output. Audio from that cell also goes to the output, so if you have selected Solo in
another cell, it will be disabled when you click Fullscreen. Click the Fullscreen button again to
return the regular Layout to the output. Re-select your Solo audio source if applicable.

Note: Going to Fullscreen is an unclean switch that my glitch on the output.

MVB2
Q ) Multiviewer Control >
v/ Multiviewer 1 Control

Multiviewer 2 Control

About this MV82

System Settings

MV82 Multiviewer 1 Control Window
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Multiviewer Control Windows (continued)
o Solo Audio Select - Select the input from which you want audio channels 1 and 2 to be
embedded into channels 1 and 2 of the output.

Note: When Solo is selected and you click Fullscreen for another cell you will hear the audio
from the Fullscreen cell. Clicking Fullscreen routes the entire video signal, including the audio,
to the output, and therefore disables Solo from another input.

MV164
Q Multiviewer Control > Multiviewer 1

Layout [ Quad Split v ]

(= solo )

Multiviewer Control window with Solo Audio selected for In 5
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Multiviewer Control Windows (continued)

» Change Screen Layout - Use the Layout pulldown menu to change between layouts that have
been enabled for operator use. Different layouts may have completely different sources.

MV164
Q Multiviewer Control > Multiviewer 1
No Layout

Layol

MV Screen 3 Layout
MV Screen 4 Layout
Program/Preview
QCc1l

Quad Split

Multiviewer Control window: Layout selection detail
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Multiviewer Control Windows (continued)

» Operate Timers - Timer cells can all function as three different types of timers. Select Time Up,
Time Down or Time Until from the pulldown menu of each timer cell as follows:

Time Up - Time up works like a stopwatch. Use the Start and Stop buttons in the lower left
hand corner of the cell. Click the Clear button in the upper right hand corner of the cell to reset
to 00:00:00. Great for segment timing.

Time Down - Great for keeping track of how much time is left in a program, or the length of
time to a commercial break. Set the amount of time you want to count down in oval entry field
located in the lower right hand corner of the cell, then click the Load button. Click Start when
you want to begin the Time Down clock.

Time Until - Time Until lets you set a time of day and then tells you how much time is
remaining until that time.

Note: Timers continue to run even if they are not on screen.

i m s

~—
.

[:' Fullscreen )

Time Up
Time Down

TTmeuntl ) (‘Load D [ Load )
San Francisco New York Brazil

06:36:10 00:00:36 m4HPam 01:36:14
(stop ) {00 ) (010000

( 01:00:00 )

Multiviewer Control Window: Timer detail with four timers, all based on different time zones

www.ensembledesigns.com MV82 and MV164 - page 71



Avenue Multiviewers, Models MV82 and MV164

Multiviewer Control Windows (continued)

» Clear a Persistent Alarm — After an Alarm Fault has cleared, if Persistent is selected in the
Alarms menu for the cell, the Cleared Alarm Notice will display over the video of the cell.
To Clear this notice, click the OK button on the lower right hand corner of the notice.

Layout | My 1 3

((Fullscreen )

Cleared
Video was: Frozen
Audio was: OK

San Francisco

02:31:01

Multiviewer Control window with an Alarm Notice on DDR4

Cleared

Video was: Frozen
Audio was: OK

| Fullscreen |

Close up of DDR4 cell with an Alarm Notice. Notice can be cleared by clicking the OK button
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?

\4

?

:;; [ - MV 1 4 Clocks
8 Sources —

Multiviewer 8x1 Example

@;—% 1/16[1/16

Chan 1 1/4
Chan 2

Chan 3
»| |Chan 4
Chan 5
Chan 6
Chan 7
Chan 8

\4

\4

A 4

llll!lll

Bunnoy

Screens

— Screen Active
Layout | MV Screen 1 ¢ || Edit )
Standard: 1080p

V Time: 0 lines
H Time: 0 clocks o

Multiviewer 8x1 diagram

The above example shows the Avenue MV82 Multiviewer set up as an 8x1, with 8 sources being fed
from the router into the Multiviewer. In this configuration all 8 sources are available on one monitor

output. Any combinations of the sources may be selected for use in the Multiviewer output. Internally
generated test signals and clocks are also available as sources to the Multiviewer.With the 4x4 or 3x3
click-to-fill grid options, just about any layout option you can think of can be achieved.
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Multiviewer 4x2 Example

CLK | 4/9 4/9 CLK
CLK CLK

1/9 11/9 [ 1/9 1/9 11/9 | 1/9

?
-

Chan 1
Chan 2
Chan 3

o
S

@;—% > 14 | 1/4

G; D g 2 Clocks |
c

L ! = 114 | 1/4
8 > 14 | 1/4

vy

Chan 2
Chan 3 @

Chan 4
G; D 2 Clocks

Screens

?
-

= B2
4 Sources 4 Sources
Screen Active Screen Active
Layout | MV Screen 1 4| Edit) Layout | MV Screen 2+ || Edit )
Standard: 1080p Standard: 1080p
V Time: 0 lines V Time: 0 lines
H Time: 0 clocks o H Time: 0 clocks o
Multiviewer 4x2 diagram

The above example shows the Avenue MV82 Multiviewer set up as a 4x2 with 8 sources from the
router being fed, 4 each into the 2 Multiviewer outputs. In this configuration 4 of the sources are
available on one monitor and the other 4 sources are available on the second monitor. Internally
generated test signals and clocks are also available as sources to the Multiviewer.The purple lines
show the 2 monitors, each with a quad split.The brown lines show the 2 monitors with layouts using
the 3x3 grid. A 4x4 grid may be used on one monitor and a 3x3 grid on the other, if desired. With the
4x4 or 3x3 click-to-fill grid options, just about any layout option you can think of can be achieved.
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Front Panel Indicators

The MV82 front edge indicators are shown and described in the diagram below:

Inputs 1-8 green LEDs:

ON when a valid SD, HD or 3G
signal is detected.

OFF when no input is
detected.

Ref green LED:

ON when locked to Avenue
frame master reference.

OFF when no external reference
is detected, or when “Internal
Reference”is selected in the
Settings>Timing & Genlock
menu.

Run green LED:

OFF A power fault or halted CPU
ON A halted CPU

FAST BLINK CPU Run error
SLOW BLINK System OK.

Note: the Run LED indicator on
this module will not be
synchronized with the run LED
indicators of other Avenue
modules in the frame.

Pwr green LED:
Indicates the presence (ON) or
absence (OFF) of power.

www.ensembledesigns.com

MV82 and MV164

Mva2
3G/HD/SD
Multiviewer
N Qlnput1
Q@ Input 2
@ Input 3
Q@ Input 4
Q@ Input5
QInput 6
@ Input 7
Q@ Input 8
Q Ref .
Network Link green LED:
3“‘("]‘;"; |_— ON when there is a valid
Q Activiy Ethernet connection.
- OFF when no valid Ethernet
Q Serial S
connection is detected.
O
Run Q Network Activity green LED:
Pwr @ ON/BLINK when there is
/ network traffic.
OFF when no network traffic is
detected.
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Front and Rear Lexans

mMva2
3G/HD/SD

Multiviewer

ENSEMBLE
DESIGNS

Q@ Input 1
Q Input 2
Q@ Input 3
Q@ Input 4
Q@ Input 5
Q@ Input 6
Q@ Input 7
Q Input 8
Q Ref
Network
Q@ Link
@ Activity|
Q@ Serial

(0]

Run @
Pwr Q

mva2
Input 1
[fall safe)

Output 2

\ [Cflﬁsﬁf;]

Input 2

F) Input 3

Input 5

Input 7

Network/Serial

MV164 lexans: front and rear, 3RU.
The MV164 is a 2 module set and takes up 2 module slots in an Avenue 3RU Frame.

MV164
3G/HD/SD

Multiviewer

ENSEMBLE
DESIGNS

Q@ Input 9
@ Input 10
Q@ Input 11
Q@ Input 12
@ Input 13
Q Input 14
@ Input 15
Q@ Input 16

Pwr Q

MV164
3G/HD/SD

Multiviewer

ENSEMBLE
DESIGNS

QInput 1
@ Input 2
Q@ Input 3
Q Input 4
Q@ Input 5
Q@ Input 6
@ Input 7
Q Input 8
Q Ref
Network
Q@ Link
Q Activity
Q Serial

(@)

Run @
Pwr Q

www.ensembledesigns.com

MV82 lexans: front, 3RU rear and 1RU rear.

% Out 2 Input 2 Input 4 Input 6 Input 8
> Input 1 Out 1
2 (fail-safe) (fail-safe) Out3 Input5  Input?

Serial/Network

.
Network/Serial

oEwo
I
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Backplane Diagram

Connect sources to Inputs 1-8.
All standard SD, HD and 3 Gb/s
video formats are accepted.

mvs2
-\ Input 1
fail-safe)

—_— —

A
Input 1 and Output 1 are

linked together by a fail-safe — 41—
relay mechanism.In the event
of a power or system failure, the
signal presented to Input 1 is
directly connected to Output 1.

-\ Output 1
(fail-safe)

H) Input 3

Network/Serial

cEe—

3RU Backplane

www.ensembledesigns.com

Input 2
Input 40

Input 8(d ,

Output 2 delivers an SDI
signal. Select between

1080i or 1080p in the
Settings>Multiviewer>Screens
menu.

Output 1 select between
1080i or 1080p in the
Settings>Multiviewer>Screens
menu.

Connect the included 23700040
Interface Adapter Cable to
provide an Ethernet connection
for web based user interface,
software upgrades and GPI
Control via a third party device,
such as the JL Cooper eBox.
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Multiviewer Control Connections

23700040 Interface Adapter Cable

Avenue Multiviewers have their own dedicated control connections. The 23700040 Interface Adapter
Cable, included with every Multiviewer, connects to the 15 pin D connector on the back of the
Avenue frame that is associated with the Multiviewer module. Use the Ethernet connection for the
Multiviewer’s web based user interface, software upgrades and GPI Control via a third party device,
such as the JL Cooper eBox.

When connecting to a network router or switch, CAT5 or CAT6 cabling should be used. The Ethernet
port can also be directly connected to a computer. The Ethernet port will auto-sense cable direction,
sO a cross-over cable is not needed.

The 23700040 adaptor “Y” cable shown below is included
with every Multiviewer. Use to connect to Ethernet.

Connect the male 15 pin D Use the Ethernet connection for
connector to the female 15 the Multiviewer’s web based user
pin D connector on the back interface, software upgrades and
of the frame that corresponds GPI Control via a third party device,
to the Multiviewer module. such as the JL Cooper eBox.
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23700040 Interface Adapter Cable Drawing and Pinouts

J1
HD15 D-Sub
Male

Growndeden 1)
Backplang
Bactguans i ode 9

Conmacts theo
askpiana 0 Moo 7

Urugat Sparea

B o brtia 10

CAT 5 compatible twisted pairs
Stranded conductors preferred

/

e
S
|
()

—NC

—NC

—NC

—NC
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Settings>External Control Menu

External Control is available using a third party device, such as the eBox from JL Cooper.

For information on how to configure third party devices, please refer to Ensemble Designs document
“Using the JL Cooper eBox with Ensemble Designs Avenue Equipment” which can be downloaded
from the following website:

http://www.ensembledesigns.com/support/avenue-support/avenue-manuals

In the Settings>External Control menu, click the Configure button to access the enable menus for GPIs
and GPOs.

MVB2
ﬁ Settings > External Control
General External Control
GPIO
Network Address Status
[ Enabled [192.168.1.102 | Not Connected
Ports
Configure »
Timing & Genlock
Test Signals
Multiviewer

Control Points

External Control |

Settings>External Control Menu
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Settings>External Control Menu (continued)

Enable GPIs by checking the enable boxes.

MV164
m Settings > External Control > GPIO
L B
MV GPI Configuration

GPI's are enabled or disabled here. Configure the action of GPI's in the Multiviewer configuration section.

RE @@ S
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24 |

Settings>External Control>>GPIO Menu as seen on a web browser
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Settings>External Control Menu (continued)

Enable GPOs by checking the enable boxes. Active High is default, un-check for Low.

MV164
m Settings > External Control > GPIO

GPI

MV GPO Configuration
Multiviewer GPO's are enabled or disabled here. Configure the action of GPO's in the Multiviewer configuration section.

Enable Active High
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Settings>External Control>>GPIO Menu as seen on a web browser
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Connecting a Timing Reference to the Avenue Frame

If you would like to feed the output of the Multiviewer to a destination that needs a reference, such as
a router, the output will be in time with the mater reference provided to the Avenue frame. In order
to genlock the Multiviewer output to a larger video system, connect a timing reference to the Master
Reference Input on the Avenue Frame, as shown below. This is a loop-through connection on the 3RU
Frame which requires a termination. On the 1RU Frame it is an internally terminated input.

Avenue 5000 Series

Master
Reference;

Reference Input on the rear of the Avenue Frame.
The loop through is terminated with a 75 ohm
termination.

The Avenue Frame Master Reference Input will accept these reference types:
NTSC or PAL analog video
HD Tri-Level Sync
10 MHz precision reference

When VITC (Vertical Interval Timecode) is present on NTSC or PAL analog composite reference sources,
it will be available to the MV82 for event scheduling.

Avenue Multiviewers can operate without an external reference by utilizing their own internal
precision quality reference generator.

Vertical and Horizontal timing adjustments are in the Settings>Multiviewer>Screens menu.
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Software Updates

Software updates for the Multiviewer modules are done via Ethernet. Software updates are free for life
and can be downloaded onto your PC or Mac from the following website:

http://www.ensembledesigns.com/support/avenue-support/avenue-software

Each Multiviewer comes with a“Y” adaptor cable that provides an Ethernet connection for software
upgrades, the Multiviewer’s web based user interface, and GPI control via a JL Cooper eBox. The
23700040 Interface Adapter Cable cable, shown below, connects to the 15 pin D connector associated
with the Multiviewer module on the back of the Avenue frame.

Note: Multiviewer software updates are done with a web browser through the Ethernet connection,
not thorough Avenue PC. Instructions for updating software is on the following page.

The 23700040 adaptor “Y” cable shown below is included
with every Multiviewer. Use to connect to Ethernet.

Connect the male 15 pin D Ethernet for network connection.
connector to the female 15 Use for the Multiviewer's web

pin D connector on the back based user interface, software

of the frame that corresponds upgrades, and GPI Control via a
to the Multiviewer module. JL Cooper eBox.
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Updating Software in your Multiviewer

Step 1. Download Current Software
Download the current software for the MV82 or MV164 Multiviewer to your PC or Mac from the
following website:

http://www.ensembledesigns.com/support/avenue-support/avenue-software

Step 2. Navigate to your Multiviewer Module through a Web Browser
On a computer that is networked to the Avenue frame, type the IP address of the Multiviewer into the
url window of your web browser. The Settings>General Information window will come up.

Step 3. Update the Module Software

In the Settings>General window, click the Choose File button. Navigate to the software that you
downloaded to your computer. Click the Start Update button. The Updating Firmware window will
come up. The updating process can take several minutes.

ﬁ Settings

General . General

Information
Network
System Name
MV164
Ports
System Information
Timing & Genlock Mocicl
MV164 - Multiviewer Lox4
Test Signals
Module Software APl WebUI
Multiviewer 1.1.3b83_j1 1.1.3b41_j1 1.1.3b37
Serial Number Module Hardware
Control Points JYRR2034 MV164 45009431 Al
External Control Bootioader Kernel
1.0.8-0024 1.0.8-0024
Security
Admin Password
|| Required
Update
Load Software
| Cheoose File | no file selected Start Update

Upload an ".esu" software update package to begin the software update
process. The update process may take several minutes. Make sure that
you don't remove power during the update process.

Settings>General window
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Updating Firmware

Waiting for device to apply update and restart.
This may take several minutes.

Updating Firmware window. The updating process can take several minutes.

www.ensembledesigns.com MV82 and MV164 - page 86



Avenue Multiviewers, Models MV82 and MV164

Warranty and Factory Service

Warranty

This module is covered by a five-year limited warranty. If you require service (under warranty or not),
please contact Ensemble Designs and ask for customer service before you return the unit. This will
allow the service technician an opportunity to provide any other suggestions for identifying the
problem and to recommend possible solutions.

tel +1 530.478.1830
fax +1530.478.1832

service@ensembledesigns.com

www.ensembledesigns.com

Factory Service

If you return equipment for repair, please get a Return Material Authorization Number (RMA) from the
factory first.

Ship the product and a written description of the problem to:

Ensemble Designs, Inc.

Attention: Customer Service RMA #####
870 Gold Flat Rd.

Nevada City, CA 95959 USA

Be sure to put your RMA number on the outside of the box.
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Specifications
Inputs
Number MV82: Eight
MV164: Sixteen
Signal Type HD Serial Digital 1.485 Gh/s,
SMPTE 274M, 292M or 296M
HD Serial Digital 2.97 Gh/s,
SMPTE 424M, 425M
SD Serial Digital 270 Mb/s, SMPTE 259M
Impedance 750
Return Loss >15 dB to 1.485 GHz
Max Cable Length 270 Mb/s 300 meters Belden 1694A

1.485 Gb/s 100 meters Belden 1694A

2.97 Gb/s 70 meters Belden 1694A

Automatic Cable Input Equalization
GPI requires LAN-based interface port. Available separately.

Input Standards

1080i 50/59.94/60
1080p 23.98/25/50
1080p 50/59.94/60
720p 50/59.94/60

SD 625i 50, 5251 59.94

Outputs
Number MV82: Two
MV164: Four
Signal Type 1080i 50, 59.94 SMPTE 274M -4,5,6
1080p 50, 59.94 SMPTE 424M, 425M
Impedance 750
Return Loss >15dB to 1.485 GHz
Output DC None (AC coupled)
Reference
Number One via frame master ref input
Signal Type Composite black, Tri-Level Sync, 10 MHz

General Specifications

Power Consumption 15 watts per module
Temperature Range 0to 40°C ambient (all specs met)
Relative Humidity 0 to 95% noncondensing
Altitude 0to 10,000 ft

Due to ongoing product development, all specifications subject to change without notice
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Glossary
AES/EBU

The digital audio standard defined as a joint effort of the Audio Engineering Society and the
European Broadcast Union. AES/EBU or AES3 describes a serial bitstream that carries two audio
channels, thus an AES stream is a stereo pair. The AES/EBU standard covers a wide range of sample
rates and quantizations (bit depths). In television systems, these will generally be 48 KHz and either
20 or 24 bits.

AFD

Active Format Description is a method to carry information regarding the aspect ratio of the video
content. The specification of AFD was standardized by SMPTE in 2007 and is now beginning to
appear in the marketplace. AFD can be included in both SD and HD SDI transport systems. There is no
legacy analog implementation. (See WSS).

ASI

A commonly used transport method for MPEG video streams, ASI or Asynchronous Serial Interface,
operates at the same 270 Mb/s data rate as SD SDI. This makes it easy to carry an ASI stream through
existing digital television infrastructure. Known more formally as DVB-ASI, this transport mechanism
can be used to carry multiple program channels.

Aspect Ratio

The ratio of the vertical and horizontal measurements of an image. 4:3 is the aspect ratio for standard
definition video formats and television and 16:9 for high definition. Converting formats of unequal
ratios is done by letterboxing (horizontal bars) or pillar boxing (vertical pillars) in order to keep the
original format’s aspect ratio.

Bandwidth

Strictly speaking, this refers to the range of frequencies (i.e. the width of the band of frequency) used
by a signal, or carried by a transmission channel. Generally, wider bandwidth will carry and reproduce
a signal with greater fidelity and accuracy.

Beta

Sony Beta SP video tape machines use an analog component format that is similar to SMPTE, but
differs in the amplitude of the color difference signals. It may also carry setup on the luminance
channel.

Bit

A binary digit, or bit, is the smallest amount of information that can be stored or transmitted digitally
by electrical, optical, magnetic, or other means. A single bit can take on one of two states: On/Off,
Low/High, Asserted/ Deasserted, etc. It is represented numerically by the numerals 1 (one) and

0 (zero). A byte, containing 8 bits, can represent 256 different states. The binary number 11010111,
for example, has the value of 215 in our base 10 numbering system. When a value is carried digitally,
each additional bit of resolution will double the number of different states that can be represented.
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Systems that operate with a greater number of bits of resolution, or quantization, will be able to
capture a signal with more detail or fidelity. Thus, a video digitizer with 12 bits of resolution will
capture 4 times as much detail as one with 10 bits.

Blanking

The Horizontal and Vertical blanking intervals of a television signal refer to the time periods between
lines and between fields. No picture information is transmitted during these times, which are required
in CRT displays to allow the electron beam to be repositioned for the start of the next line or field.
They are also used to carry synchronizing pulses which are used in transmission and recovery of the
image. Although some of these needs are disappearing, the intervals themselves are retained for
compatibility purposes. They have turned out to be very useful for the transmission of additional
content, such as teletext and embedded audio.

CAV

Component Analog Video. This is a convenient shorthand form, but it is subject to confusion. It is
sometimes used to mean ONLY color difference component formats (SMPTE or Beta), and other times
to include RGB format. In any case, a CAV signal will always require 3 connectors - either Y/R-Y/B-Y,

or R/G/B.

Checkfield

A Checkfield signal is a special test signal that stresses particular aspects of serial digital transmission.
The performance of the Phase Locked-Loops (PLLs) in an SDI receiver must be able to tolerate long
runs of 0's and 1’s. Under normal conditions, only very short runs of these are produced due to a
scrambling algorithm that is used. The Checkfield, also referred to as the Pathological test signal, will
“undo” the scrambling and cause extremely long runs to occur. This test signal is very useful for testing
transmission paths.

Chroma

The color or chroma content of a signal, consisting of the hue and saturation of the image.
See also Color Difference.

Component

In a component video system, the totality of the image is carried by three separate but related
components. This method provides the best image fidelity with the fewest artifacts, but it requires
three independent transmission paths (cables). The commonly used component formats are
Luminance and Color Difference (Y/Pr/Pb), and RGB. It was far too unwieldy in the early days of color
television to even consider component transmission.

Composite

Composite television dates back to the early days of color transmission. This scheme encodes the
color difference information onto a color subcarrier. The instantaneous phase of the subcarrier is the
color’s hue, and the amplitude is the color’s saturation or intensity. This subcarrier is then added onto
the existing luminance video signal. This trick works because the subcarrier is set at a high enough
frequency to leave spectrum for the luminance information. But it is not a seamless matter to pull
the signal apart again at the destination in order to display it or process it. The resultant artifacts of

www.ensembledesigns.com MV82 and MV164 - page 90



Avenue Multiviewers, Models MV82 and MV164

dot crawl (also referred to as chroma crawl) are only the most obvious result. Composite television is
the most commonly used format throughout the world, either as PAL or NTSC. It is also referred to as
Encoded video.

Color Difference

Color Difference systems take advantage of the details of human vision. We have more acuity in our
black and white vision than we do in color. This means that we need only the luminance information to
be carried at full bandwidth, we can scrimp on the color channels. In order to do this, RGB information
is converted to carry all of the luminance (Y is the black and white of the scene) in a single channel.
The other two channels are used to carry the “color difference”. Noted as B-Y and R-Y, these two signals
describe how a particular pixel “differs” from being purely black and white. These channels typically
have only half the bandwidth of the luminance.

Decibel (dB)

The decibel is a unit of measure used to express the ratio in the amplitude or power of two signals. A
difference of 20 dB corresponds to a 10:1 ratio between two signals, 6 dB is approximately a 2:1 ratio.
Decibels add while the ratios multiply, so 26 dB is a 20:1 ratio, and 14 dB is a 5:1 ratio. There are several
special cases of the dB scale, where the reference is implied. Thus, dBm refers to power relative to

1 milliwatt, and dBu refers to voltage relative to .775V RMS. The original unit of measure was the Bel
(10 times bigger), named after Alexander Graham Bell.

dBFS

In Digital Audio systems, the largest numerical value that can be represented is referred to as Full
Scale. No values or audio levels greater than FS can be reproduced because they would be clipped.
The nominal operating point (roughly corresponding to 0 VU) must be set below FS in order to have
headroom for audio peaks. This operating point is described relative to FS, so a digital reference level
of -20 dBFS has 20 dB of headroom before hitting the FS clipping point.

DVI

Digital Visual Interface. DVI-I (integrated) provides both digital and analog connectivity. The larger
group of pins on the connector are digital while the four pins on the right are analog.

EDH

Error Detection and Handling is a method to verify proper reception of an SDI or HD-SDI signal at the
destination. The originating device inserts a data packet in the vertical interval of the SDI signal and
every line of the HD signal which contains a checksum of the entire video frame. This checksum is
formed by adding up the numerical values of all of the samples in the frame, using a complex formula.
At the destination this same formula is applied to the incoming video and the resulting value is
compared to the one included in the transmission. If they match, then the content has all arrived with
no errors. If they don't, then an error has occurred.
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Embedded Audio

Digital Audio can be carried along in the same bitstream as an SDI or HD-SDI signal by taking
advantage of the gaps in the transmission which correspond to the horizontal and vertical intervals
of the television waveform. This technique can be very cost effective in transmission and routing, but
can also add complexity to signal handling issues because the audio content can no longer be treated
independently of the video.

Eye Pattern

To analyze a digital bitstream, the signal can be displayed visually on an oscilloscope by triggering the
horizontal timebase with a clock extracted from the stream. Since the bit positions in the stream form
a very regular cadence, the resulting display will look like an eye — an oval with slightly pointed left and
right ends. It is easy to see from this display if the eye is “open”, with a large central area that is free of
negative or positive transitions, or “closed” where those transitions are encroaching toward the center.
In the first case, the open eye indicates that recovery of data from the stream can be made reliably and
with few errors. But in the closed case data will be difficult to extract and bit errors will occur. Generally
it is jitter in the signal that is the enemy of the eye.

Frame Sync

A Frame Synchronizer is used to synchronize the timing of a video signal to coincide with a timing
reference (usually a color black signal that is distributed throughout a facility). The synchronizer
accomplishes this by writing the incoming video into a frame buffer memory under the timing
direction of the sync information contained in that video. Simultaneously the memory is being read
back by a timing system that is genlocked to a house reference. As a result, the timing or alignment of
the video frame can be adjusted so that the scan of the upper left corner of the image is happening
simultaneously on all sources. This is a requirement for both analog and digital systems in order to
perform video effects or switch glitch-free in a router. Frame synchronization can only be performed
within a single television line standard. A synchronizer will not convert an NTSC signal to a PAL signal,
it takes a standards converter to do that.

Frequency Response

A measurement of the accuracy of a system to carry or reproduce a range of signal frequencies.
Similar to Bandwidth.

H.264

The latest salvo in the compression wars is H.264 which is also known as MPEG-4 Part 10. MPEG-4
promises good results at just half the bit rate required by MPEG-2.

HD

High Definition. This two letter acronym has certainly become very popular. Here we thought it was all
about the pictures — and the radio industry stole it.
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HDMI

The High Definition Multimedia Interface comes to us from the consumer marketplace where it is
becoming the de facto standard for the digital interconnect of display devices to audio and video
sources. It is an uncompressed, all-digital interface that transmits digital video and eight channels of
digital audio. HDMI is a bit serial interface that carries the video content in digital component form
over multiple twisted-pairs. HDMI is closely related to the DVI interface for desktop computers and
their displays.

IEC

The International Electrotechnical Commission provides a wide range of worldwide standards. They
have provided standardization of the AC power connection to products by means of an IEC line cord.
The connection point uses three flat contact blades in a triangular arrangement, set in a rectangular
connector. The |IEC specification does not dictate line voltage or frequency. Therefore, the user must
take care to verify that a device either has a universal input (capable of 90 to 230 volts, either 50 or
60 Hz), or that a line voltage switch, if present, is set correctly.

Interlace

Human vision can be fooled to see motion by presenting a series of images, each with a small change
relative to the previous image. In order to eliminate the flicker, our eyes need to see more than 30
images per second. This is accomplished in television systems by dividing the lines that make up
each video frame (which run at 25 or 30 frames per second) into two fields. All of the odd-numbered
lines are transmitted in the first field, the even-numbered lines are in the second field. In this way, the
repetition rate is 50 or 60 Hz, without using more bandwidth. This trick has worked well for years, but
it introduces other temporal artifacts. Motion pictures use a slightly different technique to raise the
repetition rate from the original 24 frames that make up each second of film—they just project each
one twice.

IRE

Video level is measured on the IRE scale, where 0 IRE is black, and 100 IRE is full white. The actual
voltages that these levels correspond to can vary between formats.

ITU-R 601

This is the principal standard for standard definition component digital video. It defines the luminance
and color difference coding system that is also referred to as 4:2:2. The standard applies to both PAL
and NTSC derived signals. They both will result in an image that contains 720 pixels horizontally, with
486 vertical pixels in NTSC, and 576 vertically in PAL. Both systems use a sample clock rate of 27 MHz,
and are serialized at 270 Mb/s.

Jitter
Serial digital signals (either video or audio) are subject to the effects of jitter. This refers to the
instantaneous error that can occur from one bit to the next in the exact position of each digital

transition. Although the signal may be at the correct frequency on average, in the interim it varies.
Some bits come slightly early, others come slightly late. The measurement of this jitter is given
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either as the amount of time uncertainty or as the fraction of a bit width. For 270 Mb/s SD video, the
allowable jitter is 740 picoseconds, or 0.2 Ul (Unit Interval — one bit width). For 1.485 Gb/s HD, the
same 0.2Ul spec corresponds to just 135 pico seconds.

Luminance

The “black & white” content of the image. Human vision had more acuity in luminance, so television
systems generally devote more bandwidth to the luminance content. In component systems, the
luminance is referred to as Y.

MPEG

The Moving Picture Experts Group is an industry group that develops standards for the compression
of moving pictures for television. Their work is an on-going effort. The understanding of image
processing and information theory is constantly expanding. And the raw bandwidth of both the
hardware and software used for this work is ever increasing. Accordingly, the compression methods
available today are far superior to the algorithms that originally made the real-time compression and
decompression of television possible. Today, there are many variations of these techniques, and the
term MPEG has to some extent become a broad generic label.

Metadata

This word comes from the Greek, meta means ‘beyond’ or ‘after. When used as a prefix to ‘data; it can
be thought of as‘data about the data’ In other words, the metadata in a data stream tells you about
that data - but it is not the data itself. In the television industry, this word is sometimes used correctly
when, for example, we label as metadata the timecode which accompanies a video signal. That
timecode tells you something about the video, i.e. when it was shot, but the timecode in and of itself
is of no interest. But in our industry’s usual slovenly way in matters linguistic, the term metadata has
also come to be used to describe data that is associated with the primary video in a datastream. So
embedded audio will (incorrectly) be called metadata when it tells us nothing at all about the pictures.
Oh well.

Multi-mode

Multi-mode fibers have a larger diameter core than single mode fibers (either 50 or 62.5 microns
compared to 9 microns), and a correspondingly larger aperture. It is much easier to couple light energy
into a multi-mode fiber, but internal reflections will cause multiple “modes” of the signal to propagate
down the fiber. This will degrade the ability of the fiber to be used over long distances.

See also Single Mode.

NTSC
The color television encoding system used in North America was originally defined by the National

Television Standards Committee. This American standard has also been adopted by Canada, Mexico,
Japan, Korea, and Taiwan. (This standard is referred to disparagingly as Never Twice Same Color.)
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Optical

An optical interface between two devices carries data by modulating a light source. This light source
is typically a laser or laser diode (similar to an LED) which is turned on and off at the bitrate of the
datastream. The light is carried from one device to another through a glass fiber. The fiber’s core acts
as a waveguide or lightpipe to carry the light energy from one end to another. Optical transmission
has two very significant advantages over metallic copper cables. Firstly, it does not require that the
two endpoint devices have any electrical connection to each other. This can be very advantageous

in large facilities where problems with ground loops appear. And secondly, and most importantly, an
optical interface can carry a signal for many kilometers or miles without any degradation or loss in the
recovered signal. Copper is barely useful at distances of just 1000 feet.

Oversampling

A technique to perform digital sampling at a multiple of the required sample rate. This has the
advantage of raising the Nyquist Rate (the maximum frequency which can be reproduced by a given
sample rate) much higher than the desired passband. This allows more easily realized anti-aliasing
filters.

PAL

During the early days of color television in North America, European broadcasters developed a
competing system called Phase Alternation by Line. This slightly more complex system is better able
to withstand the differential gain and phase errors that appear in amplifiers and transmission systems.
Engineers at the BBC claim that it stands for Perfection At Last.

Pathological Test Pattern - see Checkfield
Progressive

An image scanning technique which progresses through all of the lines in a frame in a single pass.
Computer monitors all use progressive displays. This contrasts to the interlace technique common to
television systems.

Return Loss

An idealized input or output circuit will exactly match its desired impedance (generally 75 ohms) as a
purely resistive element, with no reactive (capacitive or inductive) elements. In the real world, we can
only approach the ideal. So, our real inputs and outputs will have some capacitance and inductance.
This will create impedance matching errors, especially at higher frequencies. The Return Loss of

an input or output measures how much energy is returned (reflected back due to the impedance
mismatch). For digital circuits, a return loss of 15 dB is typical. This means that the energy returned is
15 dB less than the original signal. In analog circuits, a 40 dB figure is expected.

RGB

RGB systems carry the totality of the picture information as independent Red, Green, and Blue signals.
Television is an additive color system, where all three components add to produce white. Because the
luminance (or detail) information is carried partially in each of the RGB channels, all three must be
carried at full bandwidth in order to faithfully reproduce an image.
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ScH Phase

Used in composite systems, ScH Phase measures the relative phase between the leading edge of sync
on line 1 of field 1 and a continuous subcarrier sinewave. Due to the arithmetic details of both PAL and
NTSC, this relationship is not the same at the beginning of each frame. In PAL, the pattern repeats ever
4 frames (8 fields) which is also known as the Bruch Blanking sequence. In NTSC, the repeat is every

2 frames (4 fields). This creates enormous headaches in editing systems and the system timing of
analog composite facilities.

Setup

In the NTSC Analog Composite standard, the term Setup refers to the addition of an artificial offset

or pedestal to the luminance content. This places the Black Level of the analog signal 54 mV (7.5 IRE)
positive with respect to ground. The use of Setup is a legacy from the early development of television
receivers in the vacuum tube era. This positive offset helped to prevent the horizontal retrace of the
electron beam from being visible on the CRT, even if Brightness and Contrast were mis-adjusted.
While the use of Setup did help to prevent retrace artifacts, it did so at the expense of dynamic range
(contrast) in the signal because the White Level of the signal was not changed.

Setup is optional in NTSC systems, but is never used in PAL systems (see ‘Perfection’ characteristic of
PAL). This legacy of Setup continues to persist in North American NTSC systems, while it has been
abandoned in Japan.

In the digital component world (SD and HD SDI) there is obviously no need for, and certainly every
reason to avoid, Setup. In order for the interfaces between analog and digital systems to operate

as transparently as possible, Setup must be carefully accounted for in conversion products. When
performing analog to digital conversion, Setup (if present) must be removed and the signal range
gained up to account for the 7.5% reduction in dynamic range. And when a digital signal is converted
back to analog form, Setup (if desired on the output) must be created by reducing the dynamic range
by 7.5% and adding the 54 mV positive offset. Unfortunately, there is no truly foolproof algorithm to
detect the presence of Setup automatically, so it's definitely a case of installer beware.

SDI

Serial Digital Interface. This term refers to inputs and outputs of devices that support serial digital
component video. This could refer to standard definition at 270 Mb/s, HD SDI or High Definition Serial
Digital video at 1.485 Gb/s, or to the newer 3G standard of High Definition video at 2.97 Gb/s.

SMPTE

The Society of Motion Picture and Television Engineers is a professional organization which has done
tremendous work in setting standards for both the film and television industries. The term “SMPTE" is
also shorthand for one particular component video format - luminance and color difference.

Single Mode

A Single mode (or mono mode) optical fiber carries an optical signal on a very small diameter

(9 micron) core surrounded with cladding. The small diameter means that no internally reflected
lightwaves will be propagated. Thus only the original “mode” of the signal passes down the fiber. A
single mode fiber used in an optical SDI system can carry a signal for up to 20 kilometers. Single mode
fibers require particular care in their installation due to the extremely small optical aperture that they

present at splice and connection points. See also Multi-mode.
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TBC

A Time Base Corrector is a system to reduce the Time Base Error in a signal to acceptable levels. It
accomplishes this by using a FIFO (First In, First Out) memory. The incoming video is written into the
memory using its own jittery timing. This operation is closely associated with the actual digitization of
the analog signal because the varying position of the sync timing must be mimicked by the sampling
function of the analog to digital converter. A second timing system, genlocked to a stable reference,

is used to read the video back out of the memory. The memory acts as a dynamically adjusting delay
to smooth out the imperfections in the original signal’s timing. Very often a TBC will also function as a
Frame Synchronizer. See also Frame Sync.

Time Base Error

Time base error is present when there is excessive jitter or uncertainty in the line to line output
timing of a video signal. This is commonly associated with playback from video tape recorders, and
is particularly severe with consumer type heterodyne systems like VHS. Time base error will render a
signal unusable for broadcast or editing purposes.

Timecode

Timecode, a method to uniquely identify and label every frame in a video stream, has become one of
the most recognized standards ever developed by SMPTE. It uses a 24 hour clock, consisting of hours,
minutes, seconds, and television frames. Originally recorded on a spare audio track, this 2400 baud
signal was a significant contributor to the development of video tape editing. We now refer to this as
LTC or Longitudinal Time Code because it was carried along the edge of the tape. This allowed it to

be recovered in rewind and fast forward when the picture itself could not. Timecode continues to be
useful today and is carried in the vertical interval as VITC, and as a digital packet as DVITC. Timecode is
the true metadata.

Tri-Level Sync

For many, many years, television systems used composite black as a genlock reference source. This
was a natural evolution from analog systems to digital implementations. With the advent of High
Definition television, with even higher data rates and tighter jitter requirements, problems with this
legacy genlock signal surfaced. Further, a reference signal with a 50 or 60 Hz frame rate was useless
with 24 Hz HD systems running at film rates. Today we can think of composite black as a bi-level sync
signal - it has two levels, one at sync tip and one at blanking. For HD systems, Tri-Level Sync, which has
the same blanking level (at ground) of bi-level sync, but the sync pulse now has both a negative and
a positive element. This keeps the signal symmetrically balanced so that its DC content is zero. And it
also means that the timing pickoff point is now at the point where the signal crosses blanking and is
no longer subject to variation with amplitude. This makes Tri-Level Sync a much more robust signal
and one which can be delivered with less jitter.

usB

The Universal Serial Bus, developed in the computer industry to replace the previously ubiquitous
RS-232 serial interface, now appears in many different forms and with many different uses. It actually
forms a small local area network, allowing multiple devices to coexist on a single bus where they can
be individually addressed and accessed.
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VGA
Video Graphics Array. Traditional 15-pin, analog interface between a PC and monitor.
Word Clock

Use of Word Clock to genlock digital audio devices developed in the audio recording industry. Early
digital audio products were interconnected with a massive parallel connector carrying a twisted pair
for every bit in the digital audio word. A clock signal, which is a square wave at the audio sampling
frequency, is carried on a 75 ohm coaxial cable. Early systems would daisychain this 44.1 or 48 kilohertz
clock from one device to another with coax cable and Tee connectors. On the rising edge of this Work
Clock these twisted pairs would carry the left channel, while on the falling edge, they would carry the
right channel. In most television systems using digital audio, the audio sample clock frequency (and
hence the ‘genlock’ between the audio and video worlds) is derived from the video genlock signal. But
products that are purely audio, with no video reference capability, may still require Word Clock.

WSS

Wide Screen Signaling is used in the PAL/625 video standards, both in analog and digital form, to
convey information about the aspect ratio and format of the transmitted signal. Carried in the vertical
interval, much like closed captioning, it can be used to signal a television receiver to adjust its vertical
or horizontal sizing to reflect incoming material. Although an NTSC specification for WSS exists, it
never achieved any traction in the marketplace.

YUV

Strictly speaking, YUV does not apply to component video. The letters refer to the Luminance (Y), and
the U and V encoding axes using in the PAL composite system. Since the U axis is very close to the B-Y
axis, and the V axis is very close to the R-Y axis, YUV is often used as a sort of shorthand for the more
long-winded “Y/R-Y/B-Y".

Y/Cr/Cb

In digital component video, the luminance component is Y, and the two color difference signals are
Cr (R-Y) and Cb (B-Y).

Y/Pr/Pb

In analog component video, the image is carried in three components. The luminance is Y, the R-Y
color difference signal is Pr, and the B-Y color difference signal is Pb.
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